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NOTE:

® Names and Logo are registered trademarks of Narda Safety Test Solutions GmbH — Trade names are trademarks of

the owners.

Before using this product, the related documentation must be read with great care and fully understood to familiarize

with all the safety prescriptions.

To ensure the correct use and the maximum safety level, the User shall know all the instructions and

recommendations contained in this document.

The information contained in this document is subject to change without notice.

KEY TO THE SYMBOLS USED IN THIS DOCUMENT:

& DANGER

A WARNING

4\ CAUTION

NOTICE
(ENore

The DANGER signh draws attention to a serious risk to a person’s safety,
which, if not avoided, will result in death or serious injury. All the
precautions must be fully understood and applied before proceeding.

The WARNING sign indicates a hazardous situation, which, if not avoided,
could result in death or serious injury. All the precautions must be fully
understood and applied before proceeding.

The CAUTION sign indicates a hazardous situation, which, if not avoided,
could result in minor or moderate injury.

The NOTICE sign draws attention to a potential risk of damage to the
apparatus or loss of data.

The NOTE sign draws attention to important information.

II' Notes and symbol
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1 — Installing the program

1.1 Introduction Technological advancements and the increasingly widespread use of
electronic equipment for telecommunications, data processing, industrial
automation, etc. have led to a growing new field: electromagnetic
compatibility (EMC). Because many devices work in close contact with one
another, they can generate electromagnetic interference and may therefore
work less effectively. The PMM Immunity Test program will check for this
on the basis of your equipment, setup and operating procedures.

1.2 Hardware * Pentium Il processor
requirements « Atleast 256 MB RAM
» Atleast 50 MB free hard disk space
« USB or RS232 port (or Bluetooth with optional adaptor)
« Windows™ 2000/XP/Vista operating system

@ Updates can be downloaded from www.narda-sts.it or obtained
NOTE directly from our sales department.

Document PMMISEN-11104-2.16 — © NARDA 2021
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1.3 Installation The program has to be installed on the hard disk before using it.
Go to My Computer, browse the Software Media and double-click the file

PMM Immunity Suite Setup.exe.

- R

P Immunity Suite?

B pumm Immunity Suite Setup

Welcome

Welcome to the installer far PMM Irmmunity Suite 1.00.

Itis stronaly recommended that you exit all Windows
programs hefore continuing with this installation.

[fyou have any other programs running, please click
‘Cancel, close the programs, and run this setup again.

‘Otherwise, click Mext to continue.

You can exit the installation by selecting Cancel. The following

confirmation message will appear:

[;u PMM Immunity Suite Setup

II' Installing the program

J
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@ In Windows Vista, most programs are blocked to protect your
NOTE computer. To start the installation, you may need to allow the program

to communicate.

Controlle dell'account utente

provenienza.

:‘. 7 WINEB30 exe

2 Annulla

2 Consenti

:/ Dettagli

Autore non identificato

Lz provenienza e lo scope di questo programma scne sconosciuti.

@Tenmlvada parte di un programma non identificato di accedere al computer

Utilizzare il programma esclusivamente se lo si € gia utilizzato in precedenza o se ne conosce [a

1l programma € sttendibile. La provenienza & nota ed e gia stato utilizzato in precedenza,

Controllo account utente consente di bloccare |e modifiche non autorizzate al computer,

=

The program will ask you to confirm the installation folder. Choose Next
to confirm the default directory, or Change to select a different folder.

% PMM Immunity Suite Setup

Installation Folder

— |

Install PMM Irmrmunity Suite to:

Where swold you like Phab Inmunity Suite to be installec:?

The software will be installed in the folder listed below. To select a different location,
either type ina new path, or click Change to browse for an existing folder,

X

CAProgrammiVPMM Immunity Suite

H Change... ]

Space required, 8:29 MB

Space available on selected drive:59.92 GB

) LCancel

Installation

Where would

Sfoglia per cartelle

Tnistall WinEPSOO kot

Install ¥ing

ChPragra

Space regl)

Space availl

@ [_)esktop
The softwa [E2] |L‘_'| Documenti
eithertype | 62| 'J Risorse del computer

# % Risorse di rete

Cartella: : Dacumenti

Crea nuova cartella I QK

J[ annulla ]

ent location,
I

Change...

Installing the program II'
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The software is now ready to be installed. Click Next to continue the
installation.

% PMM Immunity Suite Setup

Reaidy to Install
¥ou are novy ready to install P Immunity. Suite 1.00
! i

-

The installer now has enough infarmation to install PMM Immunity Sdite on your
computer:

The following settings will be used:
Install folder; CARrogrammiF MM Immunity Suite

Shorteut folder, FMM Imimunity Suite

Please click Mextto proceed with the installation.

A status window will appear, showing the percentage of files copied into
the specified folder.

B PMM Immunity Suite Setup

Installing PRMM Immunity Suite

Pleaze weait. .

p——— me—

Installing Files...
CAProgrammitP b Irmrmunity SuiteticoniLogobardadico

(T T T T T T T T I T TIITITIIT

Installing the program
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Once notified that the installation was successful, click Finish to
complete the process. The folder PMM Immunity Suite will be created in
your Programs folder.

5 PMM Immunity Suite Setup

Installation Successful

The PN Imrmunity Suite 1.00 installation is complete.

Thankﬁ_!rnu far choosing PMM Immunity Suitel

Flease click Finish to exit this installer.

A shortcut will appear on your desktop to allow easy access to the

75

program.

£d

PMMImmunitySuite;

Installing the program E
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1.4 Removal

The recommended procedure for uninstalling the program is as follows:
Disconnect the devices attached to the computer. In Windows XP, click

Start (in Windows Vista click the @) then All Programs, place the
cursor on PMM Immunity Suite, and click Uninstall PMM Immunity
Suite.

r:ﬁg Prograrmm Irﬂ PREM Immuniky Suite ﬂ.-PMMImmunitySuite
L_g Dati recenti » !.m Uninstall FMM- Immunits: Suite
& Impostazioni 4
,-) Cerca ¥
) Guidainlinea & supporto tecnico
3 Eseqgui...

[ Disconnetti mitke. ..
8] chiudi sessione. ..

The program can also be uninstalled using the Control Panel.

@ Use this method if the Uninstall option is not available from Start
NOTE -> All Programs.

Disconnect the devices attached to the computer. Click Start, Control
Panel, Programs and Features (in Windows Vista). Select the program
from the application list and click Remove.

% PMM Immunity Suite Cimensiani

LIEil

Ulkima

Per rimucyvers il programma dal computer inusa, v Rimuovl,

Follow the instructions displayed on the screen.

When you are prompted to remove shared files, select No. If these
files are deleted, other programs that use them may not work

properly..

Installing the program
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2 — Run the program

@ Before running the program, we recommend limiting the number of
NOTE applications in use.

You can now start the program using the desktop icon.

or, from the Windows XP Start button, selecting All Programs->PMM
Immunity Suite->PMM Immunity Suite.

& Programmi PMMImmunitySuite

[ Datirscenti 3 %, Uninstall PMM Immunity Suite
G» Irnpioskazioni 3

- Cerca 4

¥ Guida in linsa & supparto tecnico

=7 Esegui...

| %] Disconnetti mirko...
(8] chiudi sessione. ..

In Windows Vista, click the Windows icon (ﬁ ), then All Programs-
>PMM Immunity Suite->PMM Immunity Suite.

The title screen appears:

fA narda
Safety Test Solutions

ar lB'CL'I! iz Corpary

P

Immunity Suite

Document PMMISEN-11104-2.16 — © NARDA 2021
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2.1 User interface The title screen is followed by this interface:

41—>

The interface contains:
1. Title bar

2. Menu

3. Selection buttons
4. Main window

These are described in greater detail below.

II' Program lunch
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2.1.1 Title bar

From left to right, the title bar presents the icon, the name of the program,
and its release. The date and year of the release are shown in
parentheses.

" PMM Immunity Suite Rel. 1.03(11/09)  [2|[E]X]

The window control buttons (minimize/maximize/close) are also available.

If the main window is minimized, the information will be displayed on
the Windows taskbar at the bottom of the screen.

ﬁ_‘ - -
";; Etﬂ” 7 PMM Imirmis.

The program can be closed at any time, and the following confirmation
message will appear:

\:..’(} Wiould you like to exit tathe Immunity Suite?

ET T

Program lunch II'
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2.1.2 Menu The main menu contains these commands:
I:IlE T’I - Flle:
- ? (Info):
2.1.2.1 File The File dropdown menu includes:

- Open: Opens a new work session in Radiated or Conducted or

" PMM Immunity Suite Rel. ,
Automotive mode.

Open ’ " PMM Immunity Suite Rel. 2.05 {(06/11)
Mew Aukormative Key Code Filz [
Exit Qpen Radiated  CTRL+R
| D — Conducted  CTRL4D
ke it Automotive CTRL+M
Exit [
|
- New Automotive Key Code:
- Exit: Exits the program at any time (subject to confirmation):
2.1.2.2 ? (Info) The ? dropdown menu includes:
n - About: Information on the program creator and customer support.
.E'.I:u-:uut e
' Press to close the window

> About - PMM Immunity Suite v1.00

/A narda

Intermet ate Customer Support

an (B Communications Company

www.narda-sts.it support@narda-sts.it

-

Ahoik

Program lunch
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2.1.3 Selection buttons

RiC|@

2.1.4 Main window

Radiated mode

Conducted mode

A new work session can also be opened using the selection buttons under
the main menu. The third button activates the Editor.

- Select
- Select .C.
- Select A

- Select "‘J to open the Editor.

R to open a new session in Radiated mode.

to open a new session in Conducted mode.

to open a new session in Automotive mode.

Detailed instructions for the different modes are provided below.

The main window displays the active work session or editor session.

"' PMM Immunity Suite - Radiated ( IEC 61000-4-3 ) (=163
Setup table Measure
|| Bensater
Frequency
80.000
» Level
® —
Measues
iy Forward
® —
Armpifer = [ ] s
B R [
i ' AEon copler | 1 { L ] e
| Fied
L ] I—
Measure |
Setups. 1 Camponerts i Settings
: Start Test ‘ | Pau
© IEC 6100043 © 801-3-84 © No Compliant
) 16 points - 5% Status
© 4Points - 100% Status
Exit |

" PMM Imunity Suite - Conducted

Setup table
Generaton
MM Frequency
IMMUHITY.
SUITE 80.000
: 3 Level
* —
Generatar |
‘
Mea

Amplifer I

|
%5 aB
AE CON or Clamp EU
Device
—/
Measure
Setups T Components 1 Settings
Start Test \ | Pause
@ IEC 6100046
@) CON/Clamp oty
(3 Clamp + Curtent probe Status
Exit

Program lunch

[ 25 ]



narda A

Safety Test Solutions

Automotive

Editor

' PMM Immunity Suite Rel. 2.06 (10/12) - [Automotive]
¥ Fie iew

A|E

| —
EEI0 DUALE

Generator

PIMM3030

40de -40 dBt

O B+ Cunent Probe

07 Rroi Cowler |

=]
.
L
Device
iSetups 1 Cornponents Settings
®1S0 11452 - 4 ©150 11452 -5
©EBCI

Setup table Measure

O Edittable ® Make automatic tabls
B
Comment

Generalor

HMonitor

Fomard
.

Reverse

Status

Exit

il

' Editor [

CEHE& 9EdHBB 5 U s

1214 1041142009

See below for further information on these windows

Program lunch
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3.1 Introduction to
Radiated mode

?

Exit

Radiated

Zonducked |

R

3 — PMM Immunity Test
Radiated

Radiated mode tests your equipment's immunity to the magnetic fields
produced by radio transmitters or any other device that emits radiated
electromagnetic energy. This kind of radiation may be generated by
portable transceivers, base stations, television transmitters, radio
transmitters, and other electromagnetic or intermittent sources. To obtain
reproducible results, the test should be performed in an anechoic
chamber; the standard for equipment, setup and procedure is EN 61000-4-
3.

Loading Radiated Module

{ IEC 61000-4-3 )

CEE

Sev “hle | M
(1 P b O o O M 6 ihle
‘ IMBAULITY H
SUITE
e
Generator i I
, | VpErey |
Lﬁ ij ' !
Amplifer ‘I - ! |
gl w0 g i |
ol = RF D, Coupler = H '
|
| ]
|
| ]
R R S |
Setups T Compaonents T Settings ]
Measure T Break points T Chants! |
Graph type Chart Feference Reterence\Rangs dbm
Linear BackColor [ ] L e Level | 0] Range [100 w
Break points S Color I ;J - :
Color )| Trace
Curzor Generator M | ley. oA PH ReferenceRangs W/m
Color B [Feldmeter [l [“[ReversePM H  fjevel Range -10 :7_ Exit
Fig. 3-1 Main window - Radiated
This window contains:
1. Menu
2. Diagram window
3. Function tabs
4. Setup table
5. Measure
Document PMMISEN-11104-2.16 — © NARDA 2021
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3.2 Choosing the Once Radiated mode is launched, the compliance standard needs to be
compliance standard chosen. The program offers a selection under the Setups tab.
(Setups)
- EN 61000-4-3

- 801-3-84

- No Compliant

Setups T Camponents T Settings

@ IEC 61000-4-3 © 801-3-84 2 No Compliant

) 16 points - 7%

(&) 4 Paints - 1003

II' Radiated
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3.3 Equipment selection
(Components)

After selecting the compliance standard, choose the equipment to be used
during calibration or testing.

The program divides equipment by type; for your convenience, drivers from
the PMM family can be used.

To enable the desired module, double click the corresponding line (a
< will appear next to the instrument selected).

- Generators: Lists the available field generators

Generators! T Fower heters T Field Meters T
Buz |Comm,| Startfreq. | Stop freq. | Minlevel | Mas level
Selected Name  |Bustope| (5 | 00 TGS | b | (B | (dBm

DUMMY GEN GFIB ks 0 0.0 20000 -100 20
Prk 3000 R5232 S 3 0.m 1000 -a0 10
Prb 303085 R5232 S 1 0.009 3000 107 10
W Pri 3030U5E  USE S s 0.009 3000 107 10
P 30M0USE  USE ks S 0.009 1000 107 10
Prrd 30T0RS R5232 S 1 0.009 1000 107 10

- Power Meter: Lists the available power meters

Generators T Power Meters! T Field Maters
Selected MHame Buz type aBdLéSr_ E;gﬁn' St[i;tl_:gq' St[':'hﬁ'l_flr:]q' Mfgém8| Mfgﬁ'?ﬂ?'
DLk Y P LISE 1] 0 0.m G000 -40 an
Frbd EE30  LISB 1 0 0.003 3000 -40 30
W DUAL BE3D | LISE 1 0 0.003 3000 -40 30
FMM BEOD  R5485 1 1 n.m 1000 -40 27
DUAL BEO0  RS485 1 1 0.0 1000 -40 27

- Field Meters: Lists field probes, optical repeaters and field meters.

Generators T Power Meters T Field Meters!
Selected Marne Bus tupe aBdLéSL CE?{T' Probe name St[i;tl_?:]q' St[m_:':]q' Mll-,r:,}ﬁ:id MRLI:,I\]‘Jel
DURMY FM | GFIB 1] 0 0o 10000 0 200
W Pk EPBOT | R5232 1] 5 Pk EPEDT 0.0m 9250 05 RO0
PMi ORO3  R5232 1] 5  PiMEPZ30 01 3000 03 300
PMi 8063 R5232 1] 5 P EPI30 01 3000 03 300
P EPEO0  R5232 1] 5  PMi EPEOD 01 9250 014 140

- Others: Lists the amplifier, directional coupler, TEM cell or GTEM
antenna .

Generators T Power Meters T Field Meters T Others:
RF Directional Coupler Test Enviroment TEM/GTERM Amplifer
Forward Coupling | 40| dB Septum distance | 1000 m Name PMM GODON

From this tab, you can set the coupling factors of the directional coupler,
the septum distance of the TEM or GTEM (if any), and the name of the
amplifier used.

Radiated IE'
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@TE

Radiated

Additional devices can be added to each of these tables by right-clicking
and selecting Add new.

Generators! T Fowar heters T Field Maters T_
Selected MHame Bus type aBdL;IT_ EELT' St[?\:ltl_:rze]q. St[?\m_:zq' MEEBIemv]eI M[a;BIfn\]fel
DUbbY GEW  GPIB w0 om 20000 -100 20
Phdbd 3000 AS232 | | addrew 1000 -80 1a
P 3030RS  RS5232 | Jodi 3000 107 10
ki Pt 303005B  USE | 3000 A07 10
Pt 301005EB  USE | B 1000 107 1a
Fhdbd 3010R5  RS5232 ; 1000 107 10
Check Device

Immunity Suite - add Generator

Instruments name I i

Instr. driver name | |

Instr. brand ; |

Bus type | v Bus Address [

Com Port num, | 0|
Freguency rangs

From o | | MHz
Leval limits
From [ 1 to [ | uBm

Sawve Cloze

Devices can also be checked, modified or removed by right-clicking from
the corresponding line:

Generators T Powar Meters T

Buz [Comm, | Startfreq. | Stap

Selected tame Busz type addr | pert MHz] M
DUMMY GEN  GPIB A a om 20

Pt 3000 R5232 A 3 om i

PhM 3030RS  R5232 A 1 0.009 30

X JP ---:‘. ”-.é\_d-d new o : 0.003 2t
Prt 3070USE MadiFy 5 0.009 i

Phk 3010RS 0.009 L

Remove

Check Device

For connecting and setting the COM port of fiber optic
equipment, see the user manual supplied with the device.
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- Modify: changes the properties of the device.

Immunity Suite - add Generator

Instrnments ame i:'MM 3030USE |

Instr. driver name PMMBDSDU

Bus type !USEI v

Freguency range

From | n.ogg) o | 3000| MHz
Level limits
From | 10_? to | 1D| dBm

Save Cloze

- Remove: removes the device and its driver from the list.

- Check Device: makes sure the driver is working and the device is
properly connected. This option is only available for the device selected (V).

If the device is connected and the driver has been correctly installed, the
following message will appear:

PMM 3030L5B

i Driver best.....Driver works correcthy
\\.) Device test. ... .Device OK

This message will appear if the device has not been connected
properly to the work setup

P EP&01

Diiver kest. ... .Driver works correckly
Device test..... Error during Device test

If the driver of the device has not been installed properly, the screen will
show:

PMM3030U

PMM 3030058

DDE Diriver rok fourd Insktruments comunication error is occurred.
Test will be aborted

We recommend performing a device check before starting the
calibration phase or immunity test. In any case, before calibration or
testing, the program runs an automatic check and reports any errors as
described above.

Radiated II'
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3.4 Diagram window

The diagram window shows the setup to be followed on the basis of
the compliance standard and equipment selected.

e}

" PAM Immunity Suite - Radiated { IEC 61000-4-3 )

/.‘7-
PRI
IV TY
SUITE
L :
Powwer Meter | e s e
e M e r =
[ DUAL 6630 ] -
Generator LiAl-pE0 | Eé,‘n !
] i * [FMM PG00 |
' |
| i
Bmplifer [ | [
g4 oo | |
= - 0 “ar i coper B fl .
’ ' |
| i
' |
| i
e T e e e e e e i |
Setups T Components T Settings
Generators .ﬂ/ Power Meters T Field Meters T Others
Bug |Comm.| Startfreq. | Stop freq. | Min level | Max level
SE'ECEEd‘ Name: | Buslbipe) oy | “port |~ IMHz ‘ MHz) | (dBl | ()
DUMMYGEN GAB ¥ 0 001 200 4w 20
PMM3000  (Rs232 | X | 3 | 001 | 1000 | 80 | 10
PMM30I0RS RS2 | X | 1 oms w0 | A7 | 10
V. PMM3HUSE USB | X X 00m@ 300 A 10
PMM30OUSB USB | % | X oms om0 | A7 | 18
Pt 3010RS R5232 S 1 0.009 1000 -107 10

The selected devices (V) are shown at the bottom of the panel.

In addition to using the Components tab, you can move from one type of
equipment to another by clicking the label with the device's name

|_PMM 3030058 | in the diagram window.

Radiated
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3.5 Settings

After performing the setup shown in the diagram window, the calibration
and test parameters need to be set using the Measure tab:

Setups 1 Components 1 Settings. 1
lMeasure T Break points T Charts
Frequency Leyal : 3
Start | 80.000 | MHz Limit [10 ~| Vim Dwelitime | 1000.0] ms
Stop | gﬂ.ﬁi MHz J 1.0 Measires Power/field
Step | 1 % WMadulatian ) dBm & Vm
@ I Type [OFF & tultiscan
Step percent bepl [ 0 ' |

The Multiscan feature allows you to modify measurement parameters

within a given frequency range.

Immunity Suite - Radiated - MULTISCAN Setup

MultiScan Options

Stat| Stop | Step| Dwell| _Modulation | Depth| VohleName | Level | _CW
MHz MHz % ms % Vim MHz

| 27 |‘| 500 | | [ 1] ‘ [ 1000| ‘!DFF ¥| [ a0 ‘ |ble_80_30 + | ‘ (10« ‘ [ 9oa |
C | v [ | pesose vl | wflO[ |
C vl [ ||[besoso o] |[ o]0 |
| | % [ | pesim o[ ¥ |0 ]
| | | v [ | pesoso v | [ wfjOf |
3 T | o [ ||ese ]| [ oo |
- o [ 1| [pesoso o] |9l O[ ]
| | o [ | peceoee v | [ ¥]|O

. CW Dwell Time [sec] | 30 | Close |I

Radiated 3-7
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Radiated

With the Break points tab, you can set the frequencies at which
measurement will be temporarily suspended to allow a change in setup.

Measure T Break points! T Chats
F_ralﬁHz | | Comment

|_ Stop 1 | 22 | Cambia Amplificatare

(i Stop 2 : i 32 | ] Carmnbia Amplificatone

[ stop 3 | |

[Sops || - !

=

| Stop & || 1]

Each time the stop frequency is reached, a message will display the
scheduled action.

Break point 2

L
y Cambia Amplificatore

Click OK to continue measuring.

The Charts tab allows visual modifications to suit your preferences.
For each element, click on the color shown, and change it using the
Windows color box if desired.

In this tab, you can also move the reference level along the y-axis (+ and -
buttons), or change the power level and range (in dBm) and the magnetic
field range (in V/m).

[ Setups T Components T Settings ]
Measure T Break points T Charts!

Graph type Chart Feference Reference’Range dBm
Lineai BackColor [ | (] [— ] Level | o Range [100 |
Grid Color [ = — —

Break points
Color Trace

Cursar Generatar” | Forward EM. Referance\Hange Y/m

Colol - Field meter [ Reverse PM [ jevel 0| Range [0 ~|
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3.6 Settings management For each new session, the default file RadDefault.tst is loaded.
To avoid having to re-enter preferred settings, they can be saved in a single

Open setting

Save setting
Save setting as...

Display

Exit

ChrlH-O

Chrl4+5
ChrH-4

Chrl4-s

st file:

| The command File -> Save setting overwrites the file in use. If no file was

called up when the program was opened, the default file will be overwritten.

PMMImmunitySuite

-

| The following message will appear:

\‘:\l.f) The settings file will be changed, are you sure?

Mo

Choose YES to overwrite the file in use. Choose NO to cancel the operation
and return to the main window.

File -> Save setting as... Enter the file name assigned to the work session

and press Save.

Mame file;

LJ Salva |

Salva come; |F|au:|iafeu:| Immunity Settings Files [ TST]

_v_J Annulla

The file can be called up at any time with the command File -> Open

setting.

Radiated Immunity Settings File Browsing && Opening

Cercain; | I3 Var

=

& o B~

=
I@ RadDef ault, kst

Deskiop

LY/

Documenti

Rizorse del

_,.J | settings_so_s0.757

computer

‘;3 Mome file;

Risorse direte  Tipo file:

=

| Radiated Immunity Settings Files [ TST)

[ Apriin zola lettiura

_v_J Annulla

Apri |

File -> Display -> Default colors is used to restore the original display.

Radiated
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3.7 Setup table You can now calculate the levels assigned to the generator in order to
have a constant field value within the chosen frequency range.

There are different ways to create the table:
- Automatically (select Make automatic table)

- By adapting the automatically created table to the instrumentation used
(select Edit table)

- By completing the entire table manually (select Edit table)

3.7.1 Automatic table
creation

B

" PMM Immunity Suite - Radiated { IEC 61000-4-3 )

BED)

Setup table Measure
40.00 140
() Edit table ) Make automatic table
30,00 130
20,00 120 | | E]
[Comment
10.00 1.0
0:00 10.0
= - ) Conzt, Field method (O Const. Pawer method
= 000 305
0 =
I'-;'-j = I Wiew Data l [ Start Test ] [ FPause. ‘
=20.00 80 Generatar
000 5 | e MHz |
® dBm |
-40.00 g0
Field Meter
50,00 50 [ ] | _____ Vim |
£0.00 40
80.0 8.0 820 a3.0 4.0 85.0 86.0 87.0 a0 8.0 S0.0 .
MHz @
Setups T Compaonents T Settings 5
Measure T Break points T Chartsi
Graph type Chart Reference Reference\Range dBm
Linear BackColor [ ] Level 0 Range 100 v ;
- Grid Color [ :] . :
Break pointz
Color ] Trace Status
Curzor Generator: T Forward M - Reference’\Fange ¢ /m
Color i Field meter [ ReversePM I jevet | 10| Range [10 (v [ Exit

Radiated
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To create a table automatically:

- Select Make automatic table

3 Edit table 3 Make automatic table

Select (-] , assign a name to the table and press Save

(=

Norme file: tal:nle 8080 lJ Salva |
Salva come; |Table Files [* Fac) LJ Annulla

If an existing table is selected, the following message will appear:
Save FILE TABLE as X|

f C:\ProgrammiiPMM Irnmunity: SuitelCalibrationsitable_80_90.FAC esiste qia.
.

Sostituirlo?

Choose YES to overwrite the table.
Choose NO to cancel the operation and return to the main window.

- A comment can be added, if desired.

{Cammert [

- Calibration can be performed using the constant field strength method
or the constant power method (consult EMC regulations for further
details.

) Conzt, Field method () Const: Power method

- Press Start test, then Abort test if you wish to terminate the process at
any time.

[ Start Test | N [ Ahort Test l

A Pause button is also available, and becomes Continue to resume the
process.

| Fauze ‘ N [ Continue ]

Once the calibration has begun, a message will appear stating that the limit
will be multiplied by 1.8 as required by EMC regulations.

PMMImmunitySuite

Ee aware set limit will be multiplied by 1,8 during calibration,

Radiated II'
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The Generator window shows the level (in dBm) entered by the
generator, at a given frequency (in MHz), to generate the chosen magnetic

field level.
‘Geheratar

| 85.770820 MHz |
*| -32.4 dBm |

The color of the dot corresponds to the color of the line on the graph.

The field level generated inside the cell is displayed in the Field Meter

window.
Field Melet Field heter
® | 18.192 Vim | ®

Values outside the selected tolerance will be shown in red; the
generator will adjust the level to bring the magnetic field back into
range. The color of the dot corresponds to the color of the line on the
graph.

40.00 260

30.00 240

20.00 220

1000 0.0

0o 180

00 s
3

dBm

=

-20.00 140

-a000 120

-40.00 oo

5000 g0

-E0.00 (=1}
ann 21,0 g20 830 840 50 860 ar.i aan ga.0 q0.0

MHz

Meazile

Frequericy | Paints1 | Paints2 | Paointe3 | Paints 4
R [ [ ==
808000 32g | - f =i | =
B1E080)  32@ | f =i | =
f242m)  Ee7 | e f =i | =
832483 B2E | - [ =0 {0
840808 B2E | - | = | =
£49218)  B2E | - | = | =
85708 326 - | == |
e | [ [
Br4sE -~ | L L
a3 - | e _ L
I e [ == | e

oo e e |_=rs [ =

IE' Radiated
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Because the immunity test is only valid if there is an area within the
shielded chamber where field uniformity complies with the standard, the
field sensor has to be arranged in different positions. The program keeps
track of those positions in the following window:

- A Green circle indicates that the calibration has been completed.
- An Orange circle indicates calibration in course.
- A Yellow circle shows where the next calibration will take place.

The Status window shows each operation performed by the program
during the calibration phase.

Frequency Sent

Press the Exit button to leave Radiated mode (the button is deactivated
during the calibration phase).

Exit |

Radiated IE'
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3.7.1.1 Ampilifier

saturation test

When constant field calibration is complete, you may choose to run the
amplifier saturation test.

PMMImmunitySuite

9

. ‘Whould vou like to do the amplifer saturation test?

=]

Select YES to run the saturation test within the frequency range.

Amplifer saturation Test

Test @ 81.608 MHz

s

The test verifies the difference specified in EMC regulations between the
power calculated during the calibration phase with the limit 1.8 times that of
the test (Pc) and the power to be applied during the testing phase (Pt). If
the outcome is positive, the amplifier is not saturated and the system is
suitable for the immunity test.

Radiated

Otherwise, the foIIowini messaie will be disglayed:
amplifer not suitable For testing,
See A TemptSaturakion Test.bxt For detail,

In both cases, a .txt file is generated at the end of the saturation test; the
file is located in the folder PMM Immunity Test/Temp and can be viewed
from the Editor feature (see the Editor section for further information).

* Editor [C:\Programmi\PMM Immunity Suite\Temp\Saturation Test.txt] |‘__|E|&]
| G 9 M| B 7 U S | |CouierNew v | (85 sl = | C® ) &l
table 80 20 : Baturation test - 121172009 — 10.00.3E
Freg. MH=z Fc == o = Dif.
20_00 -31.31 - -26.41 = £.10
80._80 -31.47 - -36.41 = 4.94
8161 —31.51 = -36.64 = 5.33
82.42 -3l.23 = -36.48 = 5.25
83.25 -31.31 - -36.64 = 5.33
24_08 -31.14 - -z6.48 = £.34
84.92 -31.31 = -36.24 = 4.93
8577 -31.23 = -36.47 = 5.13
2662 -31.33 - -z6. 33 = 4.94
87_43 -31.3% - -36.48 = 5.09
88.37 -31.47 = -36.43 = 5.02
89.Z% -31.31 = -36.32 = 5.0Z
20.00 -3l.22 - -36.33 = 5.10
NUM N T
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3.7.2 Manual table You may also fill in the entire table manually.

creation
" PMM Immunity Suite - Radiated (IEC 61000-4-3 ) M=
Nere Setptable | Measue
Frequency Level |
go.ooooje - &) Edit tabls (0 Make automatic table
80.8000(e -
I Mierd
wazal|e
B32daije | Remove | | |
840808/ - - =
249216|e l Fill T able ] [_ Clear Table ]
8577088 -
865.E285(e Diisk
a7.4948(8 -
89.3695| [ Load Browse l
392558 -
onooon|e I Save l I Eraze l
Table infarmation
Table Name  |None |
Start 80.0000 MHz |
Stop 90.0000 MHz
Step 1.00 %
Level 10.0 Vim
Setups T Components T Settings '%
Measure ’ﬂ/ Break points T Charts
Frequency Level =
Stat [ 80.000/MHz  Limit 10 v| Vim Dwelltime | 1000 ms
Stop | ﬂﬁaal_ MHz Tolerance 1.0 Vim Measures Power /field
Step _ 10i% Madulation @ dBm O Wim
- 300.0¢ "_: Wiz Type illll AM 1KHz tultizcan
Step percent Depth | 80| % [] Enabled Exit

Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Select the desired cell, type in the value, and confirm by pressing ENTER.

M aire

Frequency
20,0000
208000
a1.6080
R24241
23,2483
24,0808
249216
a8 7708
26 E285
A7:4948
a8 3695
29,2535
90,0000

Lewval

Radiated

[ 315 ]
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The amount entered can be deleted by clicking Remove.

b cudify
o
[ Fill Table |[ s Tl ]

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

Frequency Level Frequency Level
£0,0000{ v -32.1 80.0000] v -32.1
g0e000je - A0.8000| = 322
81.6080|® - A1.6080|= -32.3
B2 4241|e e a24241| = -32.4
fa.2483|8 - A3 2483 | = -32.4
8402088 e 24,0808 | = -325
B4 9216l 24 5216|= 32k
BEF708|e e 86 7708| = 327
BB EZ2E5|e - 26 6235| = -32.8
o7 4948l a7 43438 | = -32.8
o8 3698 |e e 28 3698 | = -32.49
832535 89 2636( = -33.0
soooog)y 331 anoonn)y’ <331

The Clear Table command deletes all of the values entered. The
command must be confirmed.

Frequency Lewel
soooooly 324
soeoooly 322
sieosnly 320
mrdzlly 323
sazdmaly 324
a4os0sly 325
25216« =
R L > Are Yo Sure you
T L 4/ warit to Clear TABLE ¢
g74948le
onaE%sle -
e I Ik | annulla
qoooodle -

The Table information pane displays the main measurement settings.
Table information
Table Name i_Nq_l_u_a_
Start [
StOp | 90,0
Step L 100y
Level | 10.0 \J’fm,

Radiated
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Once all values have been entered, click Save, then type in the name of the
table and click Save again

Diizk,
I Load Browsze l
[ Save l [ Eraze l
More file: Itable_80_90 || Saa |
Salva come! | Table Files [* Fac) | Arnulla

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file:

Save FILE TABLE as

'E C1\ProgrammitPMM Immunity SuitelCalibrationsitable_80_90.FAC esiste gid.
-

Sostituirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm the
command.

ERASE FILE TABLE |§]®

Cercair: ]\_’.l Calibrations —vj = =k B
Fra,
K
Dezktop
Drocument
Risorse del
commpuker
- Nari file: [tabte_a0_a0 [ i ]
- ]
Risorse direte. Tipo file: |Table Files [* Fac) _vJ Annulla

I~ Apriin sola lettura

table_BO_90.FAC X

D Are You Sure you
x_g/ want to ERASE IT
FROM Disk #

Ik I annulla

Radiated 3-17
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3.7.3 Modifying an
existing table

' PMM Immunity Suite - Radiated ( IEC 61000-4-3 ) CEX
table 8090 Setup table Meazuns
Frequency Level
a0.0000|v 373 (&) Edit tabls: O Make automatic table
goaoov  ard
§1.6080(v 372 b adify
a2ty ar2
g3.2d83)y  av2 | Remove ] | |
B40E08| @72 ;
84 9716 |V _3?_2_ [ Fill T able. l [ Clear Table l
g5708|y  ar2
BE62EE| A2 Disk
gr4ddely  ara
858.3633|v 373 [ Load Browse ]
89.26535|v 3r.2 -
30.0000]v '3?2 [ Save ] [ Eraze l
Table infarmatian
Table Name @E_ﬁl_]_@__l
Start | 80.0000 MHz|
Stop [ 90.0000 MHz |
Step 1.00 %
Level I 10.0 Vim|
Setups T Components T Settings 3 Camment
Measure T Break points T Charts
Frequiency Leswel :
Start 80.000| MHz Limit 10 v| Vim Dwelltime | 1000 ms
Stop Q_U_aﬁl MHz Tolerng: 1.0 W/m Measures Power/ield
Step 10! Yo Madulation & dBm O V/m
900.000] MH: Type  IntAM 1KHz ~| Nl
Step percent Depth 80 % [ Enabled Setup ] Exit

An existing table can be adapted to the instrumentation used.

Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Radiated
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Call up a previously created table by clicking Load_Browse, then
selecting the table in the Table File Browsing & Opening window and
clicking Open.

Disk

|

Load Browsze

e |

Eraze l

Table File Browsing & Opening

]

Recent

Deszkiop

)

Diocumenti

Rizorze del
computer

b

Rizorze di rete

table 80 50,FAC

Cercain; | |3 Calibrations

Maorme file;

Tipo file;

Itahie_&0_30 -] Apri |

| Table Files [ Fac] ¥ Annula

I Apriin salalettira

Select the desired cell, click Remove, type in the new value, and confirm
by pressing ENTER.

iable 8090

Frequency Level
A0.0000{v"
a0.8000(%" 373
a81.6080(%" 372
a2 4241 372
83,2483 72
24,0802 (v 72
24926 C P
=L ] 72
A6 285 (v G P
a7 4948(" 373
28,3698y 373
a9 2535(" 372
30,0000y 72

f cnclify
[ B ] -37.2 dBm |
| FilTabe ] | ClearTable |

Radiated
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To delete all data, select Clear Table and confirm

Radiated

i d AreYou Sure you
4/ want ta Clear TABLE ?

2 | annilla

If several points need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

lable B0 A0 table: 8080
Frequency Lewvel Frequency Lewvel.
80.0000]v 372 20.0000(v A2
80.8000]v 373 BO.BOO00[v 373
21.6080]v 372 B1.6080(v 372
g2 4247 | g2 4240 | e ar2
332483 e 432483 = av2
a4, 0503 = a4 0202 = ar2
a4.9216| @ 34,9216 = ar2
B5.77 05| m gh. 77 g = 373
B6.6285|» BE.6255| = 373
g7.4948|v 373 B7.454a8(v 373
88,3698V 373 B8.3698(v 373
89.2535|v 372 89,2835y A2
90.0000] v 372 30,0000 372

The Table information pane displays the main measurement settings.

Table information

Table Name  table_80_90

Start 80.0000 MHz|
Stop | 90.0000 MHz
Step 1.00 %
Level | 10.0 'U'm
[Camment
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When all changes have been made, click Save, then type in the name of

the table and click Save again.

Disk

[ Load Browse l

e L]

More file: Itable_80_30 x| saka |
Salva come: |Ta|:|le Files [* Fac) _I_J Annulla

If an existing table is selected, a confirmation message will appear to make

sure you want to overwrite the file.

Save FILE TABLE as

'E C1\ProgrammitPMM Immunity SuitelCalibrationsitable_80_90.FAC esiste gid.
. Sostituirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open.

ERASE FILE TABLE

Cercair ]U Calibrations _.vj = =k El-

|e_80_90.FAC

Risorse del

cormpuater

Cal

I~ & sola lethurs

Nome file: [table_an_30 R
Risorse direte  Tipo file: |Table Filez [*.Fac) _v.J Annlla

Confirm as requested.

b d Are You Sure you
N-E/ warnit to Cleat TABLE 7

ok ] anrlla ]

Radiated
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3.8 Radiated immunity

test

p S

" PMM Immunity Suite - Radiated

{ IEC 61000-4-3 )

Once the setup table is

to Measure.

ready, the radiated immunity test can be run. Go

EEX

Setup table Measure
e G_e_n_er_atnr
[ PN 1 Frequency
IAMUIITY
SUITE 80.000
o~ /] Lewvel
! ® —
Power Meter T F T ——— = | RF
DLUAL BE30 ' |
[ Generatar | '
- Measures
| - |
g | i Forward
| ! ® B
R | I Reverse
| g g
J |—| RF D Coupler |—| [l ! ® —
: ! Field
: I ® i
e e e e e e e | 2!
[ Measure |
Setups T Companents T Settings
Measure ‘I Break paints T Charts Start Test I ‘ Pause |
Freguency Level - ) —
Stat [ 80.000 Limit [0 | Vim Dwellime | 1000 ms
Stap | 90.000| MHz "1. Measures Power/field
Step | 1.00 % Wadlaton ) dBm O Wim Status =
T 5| atus
REOFF | | Type [EUELGE ~|  Mulisoan
Step percent Depth 80| % 1 Enabled [ Setup Exit
Click Start Test.
If no setup table has been selected, the following message will appear:
PMMImmunitySuite
Mo Calibration Table selected, please select it before to continue,
Click OK, then select the table and confirm with Open.
Table File Browsing & Opening @
Cereain | ) Calibrations :] 3 e m-
: v, FCT
) = table_10v_mad Fet
Recent
@
Desktop
)
Documenti
F\ISD‘ISE del
computer  Nome file |table10v v
. Tino fie: [ Table Fies (“Fet) v [ Annua |
SO [ &pri it sola letturs
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Otherwise the message that appears is as follows:

PMMImmunitySuite

Selected Calibration Table is "table_ 104", would you like to change it?

(s I w ]

Choose Yes to view the Table File Browsing & Opening window and
select a different table. Choose No to use the file shown and open the
following data entry window (the date and time are entered
automatically).

Immunity Suite - Info & Log

Test Report
Date  |02112i2009 | Time [12.39.13
Title | [[] Company | |
ELT. | | sm| I
Ambient
Temperatule! | Humidity | |% At pressure | imh
Table table_10v Operator |
[Mote!

Enter the name of the immunity test.

Title | L)

Click and enter the test name, then Save.

Nome file: [Radiated_test_0_a0 ~|| Ssava ]
Salva come: lTe:-:l Files [ bet) _:_] annulla

If an existing test is selected, a confirmation message will appear.

Save File Report as

' Ci\ProgrammitPM Immunity SuiteiReportsiRadiated best 80 90.Ext esiste gid,
® Yy Sostibuirlo?

Fill in the fields Company, E.U.T., S/N, Temperature, Humidity, Atm.
Pressure, Operator and Note.

Radiated IE'
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The data entry window is now complete:
Immunity Suite - Info & Log

Test Repart

Date |@| Time m|

Title [Radiatled_test_80_90bd || Company MNardasTs |
ELLT. INome del dispositivo sotto test \ SN jFRDD1 aA231 |
Ambient

Table tahle_g0_ a0 l Operator |Rossi Mario

Mote:

Done

Confirm with Done to start the immunity test.

If an existing test is selected, a confirmation message will appear:

wWauld vou like to cancel the old file?
! IF MO the new data will be append
to the end of existing File.

.

Choose Yes to overwrite the data with the test in course.
Choose No to append the new data.

i

. PhM Immunity Suite - Radiated { IEC 6100043 ) A=

Setup table Measure
G0.00 Generatar
i | Frequency
4000
85.770820 MH=z

30.00 vl

2000 ® -37.2dBm

10.00

e [ RF

S om
m Measures

-10.00 |~ Forward

@ 4.5 dBm
20.00
| | Reverse
200 ® -10.4 dBm
A0
\ =l
60.00
ann a0 820 B30 240 5.0 860 B7.0 880 as0 300 [ Measure ]
MHz
Setups T Components T Settings
Measure T Break points ]’ Charts Abort Test Pause
I I e ._'\" !
| Slatus
Frequency Sent
' Nl i
b nahlad [ Setwp | [ Exit

Radiated
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During the test, the Generator window shows the level extrapolated from
the setup table and used by the generator to obtain a constant magnetic
field in the selected frequency range. The color of the dot corresponds to
the color of the line on the graph.

Generator

Frequency

82.424080 MHz

Level

¢ -37.2dBm

The Measures pane includes:

- Forward: shows the direct power measured by the power sensor.

- Reverse: shows the reflected power measured by the power sensor.

- Field: shows the magnetic field generated within the cell
The color of the dot corresponds to the color of the line on the graph.

Meazures

Fomyard

& 4.0 dBm
Reverse

® -10.4 dBm
Field

hd 3.439 Vim

During the immunity test, the frequency range, generator level and
magnetic field will be shown in graph form.

50.00
40.00
30,00
2000
1000
[ —
=
= noo
~
RERIIN]
2000
3000
A0.00
RSlRIIT
a0.0 g1.0 gzo B30 a4.0 85.0 8E.0 B7.0 g8.0 ga.0 0.0
MHz

At any time, the test can be terminated by clicking the Abort Test button
and confirming:

ABORT TEST

o, Sure you wank
\-.'/ ta FINISH?

0] ¢ | annullz I

Radiated IE'



narda A

Safety Test Solutions

Radiated

The Pause button can also be used at any time to stop the test
momentarily (the generator is set to RF OFF). In this state, an earlier
situation can be recreated or a later one can be simulated; click the RF
button (the generator is set to RF ON), adjust the frequency and level, and
click Measure to display the values.

Ganerglnl :
Freauency LIJ [
85.770820 MHz ¥
Lewvel —
| A
e -37.2dBm [y
| RF |
Meastres
4.0 dBm
) L | @}‘éi‘ 8 (1]
Measure J

Each time the Pause button is clicked, the following window will appear:

50.00 Immunity Suite - Info & Log

Test Log
4000 _
Time [ 15.56.18 |
30.00 Frequency 81.608000 MHz |
Level -37.2 dBir 7|
2000 L 372 d5m|
Field | e |
1000 Forward 5.1 dBm|
% Y Reverse -10.4 dBm|
=';: Mote:
10.00
-20.00
-30.00
40.00
-H0.00 [
Mo mo mn om0 s |
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Pressing Save assigns a marker to the current position for future
reference. At the end of the test, the saved information can be viewed
simply by hovering the cursor over the marker.

B0.00 5000
9 < o o
4000 4000 Mharker n*1 i_
s Freq. = 81.608000 MHz |
37,00 [Level =-37.2 dBm (|
a0.00 Monitor = ... —
2000 [Fwid = 5.1 dBm ‘—
20.0d
10.00
£ 1000
& 0.00
4000 0.0
2000
10.00

The button will now read Continue to resume the test.

S0.00 0 @ 6

40.00

30.00

20.00

10.00

0.o0

dBm

-10.00

-20.00

-30.00

-40.00

6000
aoo 2.0 20 230 840 850 86,0 a7 B0 230 ao.o

The status window shows each operation performed by the software
during the test.

Frequency Sent

The end of the immunity test will be announced with the message:
IEC 61000-4-3 [X]

L]
" | ,;' Test Finished

Radiated 3-27
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When the test is over, the graph can be saved in .bmp format by right-
clicking anywhere in the graph and selecting Save bmp.

G000 0 @ €)

40.00

30.00

20.00

10.00

0.00

dBm

-10.00

-20.00

-30.00

-40.00

-50.00
aon 210 220 g3.0 240 250 260 B7.0 Ba.0 23.0 a0

In the next window, assign a name to the graph and press Save.

Maome: file: | aph_tezt BO-50 V| [ Salva ]

Salva come: | bitrap T, bmip] vl[ Arinulls ]

The saved graph can be inserted into a text file using the Editor feature
(see the Editor section for details).

Press the Exit button to leave the immunity test.

| Exit

Radiated
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4 — PMM Immunity Test
Conducted

4.1 Introduction to The purpose of the test is to check the immunity of equipment, individual
conducted mode devices or systems to disturbances caused by radiofrequency
electromagnetic fields to connection cables, power cords, signal lines and

File: s ground wires. The standard for equipment, setup and procedure is EN

ﬁ Radiated | 61000-4-6
Exit

Loading Conducted Module

{

IMMUIITY
SUITE

2 o ) Ma e e
PN H

Gererator

Arnplifer Il
[_pumgooon i
[
%ﬁ daB
AE CDN or Clamp EU
Device
Setups T Components T Settings 1
Ganerators T Fower Meters T Devices! ﬂ/ Probes T Others

Man level

[dBm]
00 10
40 0
-40 10

Selected ‘ Marrie ‘ Type M[igﬁlfn\u]-al
ENCLAVF Camp
M325 | CDM
¥ EMID1  Clamp,

[ Exit

Fig. 4-1 Main window - Conducted

This window contains:
Menu

Diagram window
Function tabs
Setup table
Measure;

oo~

Document PMMISEN-11104-2.16 — © NARDA 2021

Conducted
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4.2 EN 61000-4-6 Once Conducted mode is launched, the type of setup needs to be chosen.
Setups The program offers:
- CDN/Clamp

- Clamp + Current probe

i§gy_m§ T Components T Settings

® IEC 61000-4-6

(%) CON{Clamp

(3 Clamp + Current probe

Conducted
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4.3 Equipment selection
(Components)

In this phase you will select the equipment to be used during calibration or
testing. The program divides equipment by type; for your convenience,
drivers from the PMM family can be used. To enable the desired
module, double click the corresponding line (a V will appear next to the
instrument selected).

- Generators: Lists the available field generators

Devices T Frohes

Generators! FPowveer Metars

Selected M ame Bz hupe aBd!]J:I?. I:Eglrzn. Stﬁ";tljf]q' Stﬁl_:r:]q' M['gé?_:]el MF;BI:_B;;EI

DUMMY GEN  GFIB ¥ 0 001 20000 100 20

Phdt 3000 RS232 | X | 3 00 1000 A 10

PMM 3030RS  R52322 ¥ 1 0.009 000 107 10

¥ PMM3030USB  USE ¥ | x | 0009 000 07 10

P 3010USB  LUSE ¥ % 0009 1000 A7 10

Fhdtd 201085 RE232 * 1 0004 1000 07 10

- Power Meter: Lists the available power meters

Genatators Power Meters! Devices i Probes
Selected M arne Buz type aEdL;ISr, EE:[T. S-tﬁ;ﬂf]q' S-tmjérz'ajq' M[Igali_lv]d Mfgalfn\fl

| DUMMY PM | USE # ®o 0m G000 | 40 | a0

¥ PMMEE30  USH " ®  Ooog o000 40 a0

PhM BEOD | R5485 1 1 0.01 1000 -4 27

- Device: Includes all Clamp and CDN models.

Generators T Fower Meters T
Selected Mame | Type M[EE:%El M[a;Elﬁ_:]ﬂ
| EMCLAMF Clamp -100 10
|M3-25  CDM -40] 10
K Er107 Clamp -40 10

- Current Probes: Shows current probes with the names of their calibration
files.

| Generators T Fowear Metars T Devices T Probes
Selected Mame Cal .File
W 33_1_41 33_1_411 cpf
- Others: Shows the ampilifier,
f Genetatars Fower Meters Devices T Prohes T Othersi 1
Erwironment impedance
(& 150 ohm () B0 ohm
Aimplket Attenuator
Name [PMM 6000N | [ 6l
Conducted
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@TE

Additional devices can be added to each of these tables by right-clicking
and selecting Add new.

Generators 7{ Power Metars T Cevices T Frohes
B Cararn. | Start freq. | Stop freq. | Mitlevel | Max level
et Name |Bustpe| o |00 Tt | e | B | rom)
DUMMYGEN  GFIE | 3 = === | 20000 00 20
PMM 3000 Rszzz | 4 T 1000 40 10
PMM3030RS  R5232 | ¢ ; || 3000 107 10
v PMM3030USB USE | ¢ | | 3000 107 10
PMM 30T0USE | USE b || 1000 107 10
Pk 2010RS R5232 ¢ Check Device 1000 107 10

Immunity Suite - add Generator

Instruments lame [ i

Instr. driver name |

Bustype ' ¥ |  Bus Address 0

Com Port num. [ a
Freguency range

From | | o [ | MHz
Level [imits
From [ 1 to [ | aBm

LCloze

Devices can also be checked, modified or removed by right-clicking from
the corresponding line:

Generators T Fowar Meters T Devices i
Selected Mame Buz type aBdLéSL EEE:T' St[?\:ltl_?:]q' St[Dr.’I,ljl_flr:]q'
DUMMYT GEM  GPIB ER 0. 20000
P 2000 RS232 A 3 0.m 1000
R5232 | % | 1 0.009 3000
W RINT-L-8 Wl 0.009 3000
_ | Addnew ¢ | o003 1000
PMM 3010RS | Modify | 0,009 1000

—— e ————
Check Device

For connecting and setting the COM port of fiber optic
equipment, see the user manual supplied with the device.

Conducted
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- Modify: changes the properties of the device
Immunity Suite - add Generator

Instruments raime T:'MM J030USE |

Instr. diver name IE'MMBDSDU

Bus type !USEI v

Freguency range

From | n.ooal o | 3000| MHz
Level limits
From | 07 te | 10) aBm

Save Cloze

- Remove: removes the device and its driver from the list.

- Check Device: makes sure the driver is working and the device is
properly connected. This option is only available for the device selected (V).

If the device is connected and the driver has been correctly installed, the
following message will appear:

PMM 3030U58

i Drriver best.....Driver waorks correctly
\-.J) Device kest,....Device OK

This message will appear if the device has not been connected
properly to the work setup

PMM EP601

Driver best,....Driver works correctly
Device test, ..., Error during Device test

If the driver of the device has not been installed properly, the screen will
show:

PMM3030U PMM 3030058

GOE Criver nok faund Instruments comunication error is occurred,
Test will be aborted

We recommend performing a device check before starting the
calibration phase or immunity test. In any case, before calibration or
testing, the program runs an automatic check and reports any errors as
described above.

Conducted
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4.4 Diagram window

The diagram window shows the setup to be followed on the basis of

the equipment selected.

PRI
IMMUITY
SUITE
Gererator
Amplier
%6 aB
AE CDN or Clamp EU
]
Device
EM107
Setups T Components T Settings
Generators T Faower Meters Devices Prabes T Others
Bus [ Comm | Statfieq [ Stop fieq. | Min level | Max level
Pokciad MName | Bustpe | ooy | oot | [MHZ) | (M (Bl | [dBim)
DUMMY GEN__ GPIE X | 0 0.0t 20000 00
PMM 3000 R5232 ® 3 [ullig] 1000 -B0
PhM 3030RS  Rsz3z bl 1 n.oos 3000 107
W PMM 3030LSE  USB ® *® 0.003 3000 -107
FrM 30T0USE  USB # b n.oog 1000 107
PMM 3010R5  R5232 s 1 0.003 1000 -107

Setup table

() Edit tahle:

Measure

() Maks automatic table

Exit

The selected devices (V) are shown at the bottom of the pane.

In addition to using the Components tab, you can move from one type of
equipment to another by clicking the label with the device's name

[ PMM 3030USE

Conducted
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4.5 Settings After performing the setup shown in the diagram window, the calibration
test parameters need to be set using the Measure tab:
Measure T Break points T Charts
Freguency Lewel = Z - e
Stat [ 0.50/MHz  Limit 10 v V Dwelltime | 100] ms
Stop 200.000| MHz  Tolerance [ 2,50 V
Step | 1-000: Yo Madulation
Cow ) [ owo

1 =% Type OFF b | Multizcan
Step percent epth gol £

Setup

The Multiscan feature allows you to modify measurement parameters
within a given frequency range.

P MM MULTISCAN Setup
MultiScan Options

it Stop . IStep - Dl | Modubtion | Depthl - Sdble Rame Level
MHz MHz z mSec 4 Yim
o e R x|
) ~IC = -
o o =1 el
[ | o S N
o = Bl
N o =[]l Sl
N o o | x|
N o | o =S| |

Exit

Conducted 4-7
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With the Break Points tab, you can set the frequencies at which
measurement will be temporarily suspended to allow a change in setup.

Measure if Break points! [ Charts
F_ralﬁHz | | Comment

|_ Stop 1 | 22 | Cambia Amplificatare

i_ Stop 2 : i 32 | ] Carmnbia Amplificatone

[ stop 3 | |

[Sops || - !

=

[Csons [~ ||

Each time the stop frequency is reached, a message will display the
scheduled action.

Break point 2 @

L
y Cambia Amplificatore

The break points are shown as vertical stripes in the graph.
Click OK to continue measuring.

The Charts tab allows visual modifications to suit your preferences.
For each element, click on the color shown, and change it using the
Windows color box if desired.

In this tab, you can also move the reference level along the y-axis (+ and -
buttons), or change the power level and range (in dBm), the voltage (in V)
and the current (in mA).

Breal points

Color = Trace
7 [] Genetator M [ Forward PM [
LirE0r

Color — ] Monitor B [ ReversePM

Measure T Break points T
Graph type Chart Reference position Feterence’Rangs dBm
Linear BackColor 1 Value| 0/dBin Range [100 ~ B
+ s I |
Gritl Color = :] BalataroaiRano:

Conducted



narda A

Safety Test Solutions

4.6 Settings management For each new session, the default file CondDefault.tsc is loaded. To avoid
having to re-enter preferred settings, they can be saved in a single .tsc file:

Open sekking CEElHO

Save sething Chr+5 The following message will appear

Save sething as... ChrHa

Display B PimimmunitySuite

Exit Chrl4-s

Si | ko

L3
‘_:5) The settings file wil be changed, are you suré?

| The command File -> Save setting overwrites the file in use. If no file was
- called up when the program was opened, the default file will be overwritten:

Choose YES to overwrite the file in use. Choose NO to cancel the operation
and return to the main window.

File -> Save setting as... Enter the file name assigned to the work session
and press Save.

Mome file:

Salva come;

V: [ Salva J

! Counducted Immunity Settingz Files [*.T5C)

vl[ Annulla J

The file can be called up at any time with the command File -> Open

setting.

-

Recent

Desktop

Crocumenti
o
Rizorze del
computer

«

Rizorze di rete

Conducted Immunity Settings. File Browsing && Opening

Cercain: | ) Var

- | ¢ 1? ) ,
=) condpefaul. T5C
etting_10v, TS0
[t setting._150_400.75C
Mome file; iLSetting_'I v bt i [ Apri ]
Tipo file; | Conducted Immunity Settings Files [ TSC) vi |_ Annulla ]
[ &spi i zola lettura

File -> Display -> Default colors is used to restore the original display.

Conducted
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4.7 System calibration You can now calculate the levels assigned to the generator in order to
have a constant voltage within the chosen frequency range.

Arrange the setup as shown in the graph:

' PMM Imunity Suite - Conducted

Setup table
— © Edi table
PRI
{ IMMUHITY ‘ ‘ -
SUITE itabc:_‘ID
- - | Table Automatic DEVICE=F-120
Gerieratar — !
| Start Test | Pause
Generatar
Amplifer |' ______ MHz |
| o . dBm |
Power Meter
6B [
% > e v |
P u Coupling
Davice
Setups T Compaonents T Settings
@ |IEC 61000-4-6
(&) CON/Clamp
Status
G Clamp + Current probe
[ Exit
4.7.1 Setup table There are different ways to create the table:

- Automatically (select Make automatic table)

- By adapting the automatically created table to the instrumentation
used (select Edit table)

- By completing the entire table manually (select Edit table)

Conducted
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4.7.1.1 Automatic table
creation

To create a table automatically:

- Select Make automatic table
3 Edittabls ) Make automatic table

[:] , assign a name to the table and press Save.

O

Mame fil [T able 10 v | sakva

Salva come; |Ta_l:|IeF|Ie_s[F|:t] v |[ Annulla J

- Select

If an existing table is selected, the following message will appear:

Save FILE TABLE as |

' 2\ ProgrammitPMM Immunity: Suitel Calibrationsitable_10w.FCT esiste gia.
L3 Sostituirlo?

(s I w1

Choose YES to overwrite the table.
Choose NO to cancel the operation and return to the main window.

- A comment can be added, if desired.
[T able Automatic DEVICE=F-120

- Press Start test, then Abort test if you wish to terminate the process at
any time.

[ Start Test | N [ Abort Test l

A Pause button is also available, and becomes Continue to resume the
process.

| Fauze ‘ N [ Continue ]

Conducted
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The Generator window shows the level (in dBm) entered by the
generator, at a given frequency (in MHz), to generate the voltage

required.
Genetatol -
| 34481MHz
o 2.3 dBm |

The color of the dot corresponds to the color of the line on the graph.

The voltage applied will be shown in the Power Meter window.

Fowier bdeter Power Meter

®| 1004V | ST

Values outside the selected tolerance will be shown in red; the
generator will adjust the level to bring the voltage back into range. The
color of the dot corresponds to the color of the line on the graph.

During the work session, the generator level and voltage within the
frequency range selected will be shown as a graph.

400 14.0
3000 1a.0
; S —
20000 5 oy 120
|
10.00 ™ La 10
| YA,
D.nuw Llmmrd 41
=
i
£ Jom 9.0
m ~
TG an
000 7.0
40,00 B
B0.00 5.0
000 40
015 201 401 B0 a0 o1 1201 1400 1800 1800 2000
MHz

Wait for the calibration to finish.

L3
\:‘5_) Calibration Finished

The Status window shows each operation performed by the program
during the calibration phase.

Frequency Sent

Press the Exit button to leave Conducted mode (the button is deactivated
during the calibration phase).

Exit

Conducted
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4.7.1.2 Manual table You may also fill in the entire table manually.
creation

fi ]

" PMM Imunity Suite - Conducted

MNone Setup table Measure

Freq [MHZ] Level [dBm]
01500(s - (%) Edit table
0.1515(s -
01630(s - M odify

01545|s -
_____ Bemove 22 dBm |

01551
01577 — [ FilTabe | | ClearTable ]

01532
01608
01624
01641
01657
01674
01630
01707
01724
01741
01753
01776
01734
01812
01830
01843

3

----- Diizk.

I Load Browse ‘

[ Save | [ Erase |

..... Table information

_____ Table Name gjl:luone |
..... Start 1500 MHZ
_____ Step Wl

Level I 10.0 V|

Setups T Compaonents T Settings

@ |IEC 61000-4-6

() CON/Clamp

(%) Clamp + Cument probe

[ Exit

Check the information in Setups, Components and Settings.
Go to Setup table -> Edit table.

Select the desired cell, type in the value, and confirm by pressing ENTER.

Freq.[MHZ] Level [dBm]
01500

01515 i
0.1530
01545
01561
0.15%7
01592
01608
01624
01641
01657

01674
n1ean

Conducted
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The amount entered can be deleted by clicking Remove.

W adify

[ Fill T able

I [ Clear Table |

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

Freg.[MHZ] Lewvel [dBm) Freg [MHZ) Level [dBm]
01500)v 0.2 oisooly 102
015758 - 01575 103
01654(@ - D1EG4e 104
017368 -~ 01736|e 105
018238 - n1823(e 06
01914je - 01514]e 07
02010|e - 02010)e 07
R 02111]e 08
02216|e - 0.2216|e -10.9
023278 - 0Zizis 0
024438 o2daals N
e 02566l 1.2
02634(e - 02E3dle M3
0.2528)m - nzezels N4
02570 02370l 15
03118 oallEs 16
03z7dle n3zils 6
e o438 17
e D260 18
0.3730(e - 037E0ls 113
0390 - 03380/ 120
0.4000]v 121 L o400y 121

The Clear Table command
command must be confirmed.

deletes all of the values entered. The

lf’
=/
o | Annulla

Are You Sure vou
warik to Clear TAELE 7

Freq.IMHZ] Level [dBri)
0.1500)v 102
01575V -10.2
01654V -10.2
01736 102
01823 102
01914 102
n.2010)v -10.2
211y -10.2
0.2216|=
02327 | =
02443\ =
0.2566| &
0.2634| &
0.2825|=

The Table information pane displays the main measurement settings:

Table infarmatian

Table Name ;_i'_l‘_l;!!l_p_ |
| .1500 MHz|

Start
Stop
Step

Lewvel

Conducted
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Once all values have been entered, click Save, then type in the name of the
table and click Save again.

Disk,
I Load Browsze l
[ Save J [ Erzse J
Mame fil [T able 10 v [ sava |
Salva come; iTaI:.IE Files [’;.Fct] vi [ Aprlla J

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE TABLE as

"f CriProgrammiiPMM Immunity: SuitelCalibrationsitable_10v.FCT esiste gia:
) Sostituirlo?

L s JL w ]

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm the
command.

ERASE FILE TABLE

Corcain: |l:} Calibrations V| - | ? 8 '

Recent

=N

Desktop

Lwr )

3 o
€ &

o

=

Rizorze del .
compter Marme file: I_ttals!n_a__[ﬂv | [ Apri ]

Tipo file: | Tabile Files [* Fot v [ s |
[ &pri i sola lettura

&

Rizorse direte

table_10v.FCT [X|

P Are You Sure wou
-\_g/ want ta ERASE IT
FRCM Disk, 7

[ Ok ] [ Annulla

Conducted
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4.7.1.3 Modifying an
existing table

fi ]

" PMM Imunity Suite - Conducted

table 10w Setup table Measure
Freq [MHZ] Level [dBm] -
0.1500]y -2.8
01515 -28
0.1530) -2.8
01545y -28
01561 -28 ; |
v 2
gl:g; > _g'g | Futatle | [ cearTabe |
01608 -28
0.1624|v -2.8 Digk
01641 v -28
AEST| v ] I Load Browse ]
01E74| -2.8
TRE= T [ swe | [ b |
017071 -2.8
0724 -28 Table infarmation
oy 2R —
01759 BX] Table Name [table_10v |
BiTogY <28 Start [ 1500 MHz|
R T Stop | 200.0000 MHz |
01830V 28 Step ! i
oisdaly 28 R ——
Level | 10.0 V|
Seligs Companents i Settings [T able sutomatic DEVICE=F-120
Measure Break points T Charts

Frequency Level - = =

Start [0 0.150|MHz Limit [10 | v Dwelltime. | 100| ms

Stop | 200.000] MHz Tolerance | 250 V

Step % M odulation =

( M Type  |IntAM 1KHz | Mtiscarn

Step percent Depth 0| o Setup

Exit

An existing table can be adapted to the instrumentation used.

Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Conducted
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Call up a previously created table by clicking Load_Browse, then
selecting the table and clicking Open.

Disk
I Load Browsze l
[ Save l [ Eraze l
Table File Browsing & Opening @
Cerca in: | I Calibrations V| > 5 el
Recent

Desktop

Crocumenti

o
Risorse del : =
Computer Mome file: [table_T0v bl [ Ao ]

‘:_ Tipo file; |Table Files {".Fct] vi |_ Annulla ]
[ &spi i zola lettura

Rizorze di rete

Select the desired cell, click Remove, type in the new value, and
confirm by pressing ENTER.

table T0v
Freq.[MHZ] Level [dBm]

0.1500[v 28
01515|v 28 B
01530]v 23
0.1545| 28
0156T|v 2.3
0A577|v 28
0.1692(v -2.8 b odify
01e08|v 28 r i
D124y 28 [ Remave l rRZ B |
01641|v 23 7
LSy 28 [ Fill T able ] | Clear Table ]
0.1674|v 28
A camles il

Conducted 4-17
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To delete all data, select Clear Table and confirm.

5 Are Nou: Sure you
-.",/' want to Clear TAELE 7

ok | annulla

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

tabla_150. 400 abla 150400
Freq.[MHZ] Level [dBm) - | Freq.[MHZ] Level [dBm] - |
o500y 0z ] ois00y 0.2
0A5T6Y 02 057y 02
0iE54y 0.2 01654y 0.2
0A7ElY 02 0A7ElY 02
01823 e 0iazale 04
01914s oi1a4ls 07
0.2010] s Dzoidle 04
0.2111|e oaTl|s A1z
D22Ely 114 D221Ely 14
n2az|ly 114 D23y 14
o243y 14 D243y 14
D25EElY 114 D25EEY 14
02634y 114 D265y 14
g2azsly 114 Dossly 14
gzarly 114 gearly 14
038y 114 oasly 14
Dazaly a1 nazvaly 24
03Ey 21 D343y 21
03Iy 21 03Iy 21
oarly A4 narly 24
R TR R CE
o4000y  dz1 B3 o000y 21 B

The Table information pane displays the main measurement settings.

Table information

Table Name  [None [
Start 1500 WiHz|

Stop ~ 200.0000 MHz|
Step 1.00 %)
Level 1DUV

Conducted
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Once all values have been entered, click Save, then type in the name of the
table and click Save again.

Disk,
I Load Browsze l
[ Save J [ Erzse J
Mame fil [T able 10 v [ sava |
Salva come; iTaI:.IE Files [’;.Fct] vi [ Aprlla J

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE TABLE as

"f CriProgrammiiPMM Immunity: SuitelCalibrationsitable_10v.FCT esiste gia:
) Sostituirlo?

L s JL w ]

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm
the command.

Corcain: |l:} Calibrations V| - | ? 8 '

Recent

=N

Desktop

Lwr )

3 o
€ &

o

=

Rizorze del .
compter Marme file: I_ttals!n_a__[ﬂv | [ Apri ]

Tipo file: | Tabile Files [* Fot v [ s |
[ &pri i sola lettura

&

Rizorse direte

table_10v.FCT [X|

P Are You Sure wou
-\_g/ want ta ERASE IT
FRCM Disk, 7

[ Ok ] [ Annulla
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4.8 Immunity test WITH If an injection clamp is used, the AE configuration must present

Impedance common-mode impedance (consult EMC regulations for further details).
Requirements
(Setups) If the impedance requirements are satisfied, select CDN/Clamp.

7 PMM Imunity Suite - Conducted

—
PRI
TMRIIIT Y
SUITE

Gereratar
i
Amplifer M
i
%6 {B
AE CDN or Clamp EU
| —— |
Device
F-120
Setups T Camponents T Settings

@ IEC 61000-4-6

) Clamp + Current probe.

Conducted



narda A

Safety Test Solutions

4.8.1 Starting the test Go to Measure.

” EE

" PMM Imunity Suite - Conducted

Setup table Measure
1ae Generator
Frequency
3000
3977 MHz

20.00 Lol

1000 ® -2.8 dBm

000

| R

£ o000
m Messues
- \

20,00

-30.00

-40.00

000

¥
-B0.00
015 201 401 601 1201 1400 1800 1800 2000 [ — ]
1 Abort Test H Pause ]
T —
= —
T ol Status
. (P Sending Level ‘
. o= ferw - Exit ]
Click Start Test.

message will appear:

If no setup table has been selected, the following

PMMImmunitySuite

Mo Calibration Table selected, please select it befare to continue.

Click OK, then select the table and confirm with Open.

Table File Browsing & Opening

Cercain | =) Calbrations v
Recent

Desktop

Documenti

Risorse del
computer

Morme fie; (table_10v [ e |

Tipa file: | Table Files [ Fet]

VH Arula ]

Risorse di rete [ Api i sola letturs

Conducted
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Otherwise the message that appears is as follows:
PMMImmunitySuite

Selected Calibration Table is "table 100", wiould you like ko change it?

s J[ e |

Choose Yes to view the Table File Browsing & Opening window and
select a different table. Choose No to use the file shown and open the
following data entry window (the date and time are entered
automatically).

Immunity Suite - Info & Log

Test Repart

Date  [02112:2009 | Time  [12.30.18]

Title | |[.] Company | |
ELT. | | sm| |
Ambiesnt

Temperature | | Humidity | |%  Bum. pressure | imh
Table table_10v Operator |

IMote:

Done

Enter the name of the immunity test.

Title | ]

Click [:] and enter the test name, then Save.

Muarne file: El:mljut:tEEEI teat 00| V| | Salva |

Salva come: 1T8Hl File:s [ tut] Lj Anrulla

If an existing test is selected, a confirmation message will appear.

Save File Report as

A ProgrammiiPM Immunity Suite\ReportsiConducted test_80_90.kxt esiste gia.
. Sostituirlo?

Fill in the fields Company, E.U.T., S/N, Temperature, Humidity, Atm.
Pressure, Operator and Note.

Conducted
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The data entry window is now complete:
Immunity Suite - Info & Log

Test Report
Title [Conducted_test_10v.64 |[L] company NardasTs |
E.LLT. [Nome del dispositivo sotto test | s [FrRoo15A231 !
Ambient

Temperatmel 22| Humidity | sg/% Atm. plessulei 11ggi|nh

Table [table 10v | Operator |Rossi Mario

MNote:

Dane Abort

Confirm with Done to start the immunity test.
If an existing test is selected, a confirmation message will appear:

whould you like to cancel the old file?
! If MO the new data will be append
to the end of existing File.

= 1w ]

Choose Yes to overwrite the data with the test in course.

Choose No to append the new data.

' PMM Imunity Suite - Conducted

EEX

Setup table Measure
4000 Generator
Frequency
3000
54.2432 MHz
2000 Livel
10.00 L -1.5 dBm
0.00 [ RE
=
= 000
m Measures
20.00 y
3000
-40.00
A0.00 —
"
H0.00
015 201 40.1 B0.1 80,1 10019 1201 140.0 1600 1800 200.0 [ Measure ]
MHz
I i !
| Abort Test Pause
il
. = || DT
} -
|
T ) . i Status
fale | 10 W Ranpe|10 f
> o — Sending Level ‘
= = i i
=1 it = T B | vae| 66.7|jna Rangs[1ooma « | [ Exit |

Conducted
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During the test, the Generator window shows the level extrapolated
from the setup table and used by the generator to obtain the required
voltage.

The color of the dot corresponds to the color of the line on the graph

Frequency

6101 MHz

Level

® -2.8 dEm

During the test, the frequency range and generator level will be shown in
graph form.

40,00

3000

20,00

1000

n.oo

A0on

dBm

-20.00

30,00

-40.00

G000

-B0.00
015 201 401 B0 a0 1001 1201 140.0 1600 1800 2000

MHz
At any time, the test can be terminated by clicking the Abort Test button
and confirming:
ABORT TEST X
b Sure you wank
'*-E/ ta FINISH?

0] 4 annulla |

Conducted
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The Pause button can also be used at any time to stop the test
momentarily (the generator is set to RF OFF).

In this state, an earlier situation can be recreated or a later one can be
simulated; click the RF button (the generator is set to RF ON), adjust the
frequency and level with the arrows, and click Measure to display the

voltage.
Ge_ner_ator _

Frequency
(4]
8306 MHz |y

Lewel
¢ -28dBm |5
[ RF l

Measures
[ Measure ]

Each time the Pause button is clicked, the following window will appear:

Immunity Suite - Info & Log

[ 19.30.01 |

40.00
Test Log
250 Time
20.00 Frequency
Level
10.00
I Monitor
0.0 Forward
—
o Reverse
= 1000
m MNote:
=
-20.00
-30.00
-40.00
50,00
000
015 2041 401 601 801 1001 1201 1408
MiH=
Conducted
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Pressing Save assigns a marker to the current position for future
reference. At the end of the test, the saved information can be viewed
simply by hovering the cursor over the marker.

1) & O [ | (& |
'I'u-[&rkernﬂ ]

Freq. = 138.2148 MHz
Level =-1.8 dBm

The button will now read Continue to resume the test.

40,00 0

3000

>

20,00

1000

n.oo

-10on

dBm

-20.00

30,00

-40.00

50,00

-B0.00
015 201 401 B0 a0 1001 1201 140.0 1600 1800 2000

MHz
The status window shows each operation performed by the software

during the test.
Frequency Sent

The end of the immunity test will be announced with the message:

3

L
1) TestFinished

Conducted
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When the test is over, the graph can be saved in .bomp format by right-
clicking anywhere in the graph and selecting Save bmp.

40,000 o a
3000

20.00

1000

000

1000

dBm

-20.00

-30.00

-40.00

H0.00

-B0.00
015 20.1 401 B0.1 801 1004 1201 140.0 1600 1800 2000

MHz

In the next window, assign a name to the graph and press Save.

Maome: file: | aph_tezt BO-50 V| [ Salva ]

Salva come: | bitrap T, bmip] vl[ Arinulls ]

The saved graph can be inserted into a text file using the Editor feature
(see the Editor section for details).

Press the Exit button to leave the immunity test..
| Exit

Conducted 4-27
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4.9 Immunity test If the impedance requirements cannot be met, the current produced by
WITHOUT impedance the induced voltage must be checked using a supplementary probe
requirements (Setups) placed between the injection clamp and the EUT (see EMC regulations

for further details). For this configuration, select Clamp + Current probe.

' PAM Imunity Suite - Conducted

Fhan
IRALINTY
SUITE

Gernerator

PMM 3030USE

Power Meter

Amplifer
PIM 60001 |

EU
Setups T Components T Settings

® IEC 61000-4-6

() COMAClamp

This procedure provides only significant differences with respect to the
previous test.

Conducted
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4.9.1 Monitoring the Go to Measure.
current

CIEX]

' PMM Imunity Suite - CondLRted

Setup table Measure

40.00 100.0 Generator

— S | Frequency

Al

1624 MHz
20,00 200 Level
10.00 200 ® -2.8 dBm
0.00 600 | s

= e
= 000 5005
% }:, Itdeasu[es

2000 400 Mt

hd 2.02 mA

3000 a0 e

-40.00 200

-A0.00 100 —

£0.00 o

018 201 401 601 801 1003 1201 1400 160D 1800 200.0 [ MEHSIiE ]

MHz

amporients

Abort Test l [ Pause

Statuz
Sending Level

Forward PN N
Reverse P I

[ Exit |

The example below shows the current and the generator level during a test
in which the current limit is exceeded and then brought back into range by
the software. The correct generator levels will be saved and used during
the second sweep.

4000 | 1000
30.00 I 300
2000 800
10.00 700
0.00 ___1\ L Fo
i / \ f
-
= 1000 B0 S
1] / | 2
T2 / ana
2000 a0,
7 . f
20,00 b4 i 300
4000 ,/ 200
,_(f
50,00 y o \L/ 100
e
£0.00 00
015 201 401 E31 @a1 1Al 1201 1400 1eD0 1800 2000
MHz
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4.9.2 Second Sweep

When the process has finished, you can save the new table calculated
during the first sweep. If no name is assigned, the program will use the
name of the previous table and add " modified" (e.g. tabc_
10v_moadified.fct).

After the file is saved, a prompt will appear to conduct a second sweep
with the new table.

\_:.’/ Whould you like to start the secord sweep

The graph below shows the new generator levels applied during the second
sweep.
JRIC G|

2

Setup table Me
4000 100.0 B irstor
I Frequency
0.00 a0
200.0000 MH
20,00 &0 Tovel
10,00 700 L ] 1.3 dBm
i
0.00 nn |—PF s
= W —_—
= q0m N 503
m | Measues
2000 W00 Moritor
30,00 i)
40.00 200 —
5000 0.0 —
0,00 00 - :
018 201 401 B0 201 1001 120 1400 1E0.0 1800 2000 m
MHz
Setups T Components T Settings 2
Measure Il Break points | Charts Start Test | Pal
Rrark hine Chint Referanra nasitiin Bafarenrel Ranne dRrn 2
< | E

At the end of the test, the table will appear with the new values marked

by a red dot.
L ABR4 Y -THLE
01736V 0.2
01823 @ -10.4
0.1914|m 0.7
02070 e -10.9
02177 (m -11.2
st ol 44 4

Conducted
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5 — PMM Immunity Test

Automotive
5.1 Introduction to The purpose of the test is to check the immunity of equipment, individual
conducted mode devices or systems to disturbances caused by radiofrequency
electromagnetic fields to connection cables, power cords, signal lines and
 PMM Immunity Suite Rel. 2.06 (10412) ground wires. The standard for equipment, setup and procedure is EN
61000-4-6.

ot

trl+0

Hew Automative Key Code

Exit

Loading Automotive Module
—————

PIAM
IMMUHITY

Generator
GEHERATORE 3030

Amplifer M
1 0 d
AE = EUT
[DEVICE NAHE|
iSetups 1 Carnponents [ Settings
@ 1SO 11452 - 4 OIS0 11452 -5

@EBCI 9

() BCI + Curent Probe

Exit

Fig. 5-1 Main window - Automotive

This window contains:
Menu

Diagram window
Function tabs
Setup table
Measure;

U A R

Document PMMISEN-11104-2.16 — © NARDA 2021

Automotive II'
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5.1.1 Automotive option The Automotive section of the Software suite is an optional
activation feature.

To enable the Automotive test, use the Automotive Key Code tool in the

program.
@ For further information on software installation refer to the “Installing
NOTE the program” chapter.

G e e Click on “File” and choose “New Automotive Key code” for running the

Set code utility, so getting the following window:

Cpen 3

= M

Exit
' Instruments name | PMM3030 v|

Bus type Comm Port n®

K.ep code
|EI1 2345573901 2345678901 2345678901 2345678 |

[ J [ e |

Select the proper instrument model, the bus type and eventually the port for
communicating with it, and simply copy the 40 Digit Serial Code in the Key
Code text box, then select Window and select the Try button.

This message appears when the Key code is not valid.

PMMImmunitySuite (%]

L] "_n. Wrong Serial Mumber ID
[ ]

Or it is not the right code for your instrument:

@ Sorry, Your kew code is nok correct! Contack your dealer For any questions,

II' Automotive
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CENore

5.2 EN 61000-4-6
Setups

It will be shown the following progress bar indicating the module is being
loaded.

Loading Automotive Module

—

This means also the Key Code has been successfully stored.

Then the module is ready to be used.

To use the Automotive tool, the registered PMM signal generator must be
correctly connected to the PC running the software and switched on.

If the generator is unconnected or switched off the following message
appears:

PMM Immunity Suite

PMM Generator nok found. Connect and switch on PMM Generator and rekrey.

Once Automotive mode is run, the type of setup needs to be chosen.
The program offers:

- 1SO 11452-4 with BCI and, in case, Current Probe

- ISO 11452-5 with Stripline

Setups T Compaonents T Settings

@S0 11452 - 4 OIS0 11452 -5

@ EBCI

() B CI + Current Probe

Automotive IE'
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5.3 Equipment selection
(Components)

In this phase you will select the equipment to be used during calibration or
testing. The program divides equipment by type; for your convenience,
drivers from the PMM family can be used. To enable the desired
module, double click the corresponding line (a V will appear next to the
instrument selected).

- Generators: Example list of the available field generators

Generators T Power Meters T Field Meters T Devices T Current Probes T Others
Bus [Comm.| Start freq. | Stop freq. | Min level | Max level
Sl ‘ e ‘ Sl ‘ Bustype | dr | part | (MH2) ‘ (MHz] ‘ [Bml | (dBm)
W oorwETOD204 RSZ232 x 1 0.009 3000 -107 10
STUB3030 LSE * * 0.003 3000 107 10
PrAtd 3000 Pk 3000 R5232 x 2 0.01 3000 -80 10
Phakd 3010 Phdtd 3010 LSE b b 0.003 1000 107 10
- Power Meter: Lists the available power meters
Generators Power Meters T Field Meters T Devices T Current Probes T Others
" Buz |Comm.| Startfreq. | Stop freq. | Minlevel | Max level
Selected MNarme ‘ Position SN ‘ Bus type addr. it iMHz] ‘ MHz] ‘ B i
Monitor | 00010317
FPMMEE30 | Forward | O0CMw3<10302 UsSE x® x® 0.009 3000 -40 30
Feverse | 000WESOD306
Forward | 00010302
W 24 PMMEE30 Reverse | OOOWESDI0E UsSE x® x® 0.009 3000 -40 30
Fornward FRIMARY
DUAL BEOO Biesersn | CECNNDARSY R5485 0 3 n0.m 1000 -40 27
- Device: Includes all BCI models.
Generators 1 Power Meters 1 Field Meters | Devices!
bin level | Max level
Selected MHame S/N Type [dEim] [dBim]
b DEYICE MAME Device S/M | B.C.I. -30

- Current Probes: Shows current probes with the names of their calibration
files.

| Generators T Powar Matars T Devices T EPmI:es!
Selected Marme Cal .File
W 331 411 33.1_411.cpf
- Others: Shows the ampilifier,
Genetatars T Fower Meters T Devices T Prohes T Othersi

Erwironment impedance

(5 150 ohm O 50 ohm
Amplifer
Attenuator
Name |[PMM 6000N L[ slee

Automotive
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@TE

Additional devices can be added to each of these tables by right-clicking
and selecting Add new.

Generators ‘f Power Meters T Cevices T Frobes
B Comm. | Start freq, | Stop freq. | Minlevel | Max level
grlected Name | Bustype| oo (00| T RiHa) | M2 | (dBe) | (Bl
DUMMY GEN  GPIE T 20000 100 20
PMM 2000 Rszzz | 3 U 1000 0 10
PMM 3030RS  RS23Z | 2000 107 10
¥ | PMM 3030USB | USE b 3000 107 10
PMM 30100SE | USE P 1000 107 10
Pk 301 0RS R5232 ¢+ CheckDevice 1000 107 10

Immunity Suite - add Generator

Instruments name

Instr. driver n

alne

Prir 3000

Bus type |R5232 «

SN

Freguency range

From

Level limits

From

-80

w

Comm Portn®| 1

3000 MHz

10| dBm

Save LCloze

Devices can also be checked, modified or removed by right-clicking from
the corresponding line:

—_— Refmove

Check Device

Generators T Fower Meters T Devices
Selected Mame Buz type aBdL;ISL Eggﬁn. St[‘?\:lt'jf]q' Stlobm_?;]q'

DUMMY GEM  GPIB ER 0.0 20000
Prdkd 3000 R5232 # 3 om 1000
PMM3030RS  |RS232 | x| 1 0,003 3000

v if fEAILL ¥ % 0.003 3000
Phb 3010056 | Add new ¢ | ooog 1000
PHM 3010RS Modify 0,009 1000

For connecting and setting the COM port of fiber optic
equipment, see the user manual supplied with the device.

Automotive
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- Modify: changes the properties of the device

Instruments name [PMM 3030USE |

Instr. driver name EE‘MMEGSDU i

Bus type !USEI v-

Frequency range

From | n.o0s| o | 3000| MHz
Level limits
From | 10_? to | 1D| dBm

It is possible to modify any of the parameters but the name.
- Remove: removes the device and its driver from the list.

- Check Device: makes sure the driver is working and the device is
properly connected. This option is only available for the device selected (V).

If the device is connected and the driver has been correctly installed, the
following message will appear:

P 3030058

i Drriver test... . .Driver works correctly
\-u) Device test,. .. Device 0K

This message will appear if the device has not been connected
properly to the work setup

PiM EP601

Drriver test, ... .Driver works correckly
Device kest..... Error during Device test

If the driver of the device has not been installed properly, the screen will
show:

PMM3030U PMM 3030058

DDE Diriver rok fourd Insktruments comunication error is occurred.
Test will be aborted

We recommend performing a device check before starting the
calibration phase or immunity test. In any case, before calibration or
testing, the program runs an automatic check and reports any errors as
described above.

Automotive
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5.4 Diagram window

The diagram window shows the setup to be followed on the basis of

the equipment selected.

PMM Immunity Suite Rel. 2.06 {(10/12) - [Automotive]

EEX
T8 Fle view NEE]
LR
Setup table Measure
Generator
PMM Frequency
80.000
Lewel
[ ] —
Generatar [ RF ][ WoD
b
Measuies
rplifer 0
-40dB -40dB
[_Pmmsooon |
Crmmastoon I "5, coppier 1
Fomward
L ] [R—
AE BCl EUT Hevase
Device
[DEWICE NAME]
[ Measure |
Setups T Components T Settings
Generators T Power Meters T Field Meters T Devices TcurraumhEsT Others Start Test Pause
Bus |Comm | Start freq, | Stop freq. | Min level | Mas leve
Selected MName | SN Buspe | 4 (0 | ik WHo | B | T
W (GENERATORE 3030 ¢ OOOWE7N204  RS232 | % 1 0,009 3000 07 0
STUB3030 STUB303  USB ®ox 0.009 3000 07 10 Status
Pt 3000 PMM 3000 RSZ: | R 2 om 3000 €0 10 Status
PHM 3010 PhiM 2010 Use pad b3 0.009 1000 107 10
sl Exit

The selected devices () are shown at the bottom of the pane.

In addition to using the Components tab, you can move from one type of
equipment to another by clicking the label with the device's name

| PMM 3030USBE

| in the diagram window

Automotive 5-7
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5.5 Settings

After performing the setup shown in the diagram window, the calibration
test parameters need to be set using the Measure tab:

Setups T Components T Settings ]
Measure T Break points T Charts
Frequency Lirnit narme todulation
Start MHz |Default | E] Type
Stop MHz Power limit Factor X Depth %
Step MHz Peak conservation
Multizcan
[ step percent RBIUITTE ms

In the limit box there is also the choice for the Peak conservation. This is
useful to satisfy those regulations requiring that under the condition of
amplitude modulated signals the peak level must be the same of the
unmodulated ones used for system calibration. It works both for AM and
Pulse modulations.

All the modulation types, most common in the standards, are available
depending on the model of the generator in use.

The Multiscan feature allows you to modify measurement parameters
within a given frequency range.

PMM  MULTISCAN Setup

H:_::ican g:::m atep |- Dwell b - Modalation | Depthl Sldbie Rome Level
MHz MHz z mSec 4 Yim
1 o o i S| A
| | =l i
[ B B
[ | B Bl
[ o o Bl B
N o S Sl
[ =1l i
I | S| ER

Automotive
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With the Break Points tab, you can set the frequencies at which
measurement will be temporarily suspended to allow a change in setup.

Measure T Break points T Charts

= JMPFI | Comment

Cambia Amplificatore

Cambia Amplificatare 1

Each time the stop frequency is reached, a message will display the
scheduled action.

Break point 2

.3
_I.‘) Cambia Amplificatore

The break points are shown as vertical stripes in the graph.
Click OK to continue measuring.

The Charts tab allows visual modifications to suit your preferences.
For each element, click on the color shown, and change it using the
Windows color box if desired.

In this tab, you can also move the reference level along the y-axis (+ and -
buttons), or change the power level and range (in dBm), the voltage (in V)
and the current (in mA).

Break: points

Color = Ttace

% Generator [l [ Forward P [
ursor

Color — ] Maniito B [ ReversePM

Measure T Break points T Charts!
Graphbype Chiart Reference position Reterence’R angs dim
Linear BackColor [ ] Value| 0}dBin Range [100 + |8
+ S | | S i)
Grid Color (| [:] e

Automotive
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5.6 Settings management For each new session, the default file CondDefault.tsc is loaded. To avoid

Open setting

Save setting
Save setting as...

Display

Exit

ChrlH-O

Chrl4+5
ChrH-4

having to re-enter preferred settings, they can be saved in a single .tsc file:

| The command File -> Save setting overwrites the file in use. If no file was
| called up when the program was opened, the default file will be overwritten:

The following message will appear

PMMImmunitySuite

kel =
‘_:5) The settings file will be changed, are you surée?
Si | ko
Choose YES to overwrite the file in use. Choose NO to cancel the operation
and return to the main window.
File -> Save setting as... Enter the file name assigned to the work session
and press Save.
Home file: |Settings-.-'1‘-.ut|:|mcutive V| [ Salva ]
Salva come: |.-'1'-.ut|:|m-:|tive Settings Files [*.tza V| [ Apnnulla ]
The file can be called up at any time with the command File -> Open
setting.
Automotive Immunity Settings File Browsing && Opening
Cerca i |i=;')\-"ar "l o ? » -
£y T@I AukoDefault, T5A
[_-']g ol Autamative tsa
Documenti
recenti
e
Desktop
Documenti
’_j"l_g
Rizorze del -
computer MHorme file: ;’-‘-:_L_J_t_omotive.tia V_I I Apri ]
e Tipo file; |.&utomotive Settings Files [ tza) v-I [_ Annulla ]
Hisor_sé o [] &pri it z0la lettura
File -> Display -> Default colors is used to restore the original display.
Automotive
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5.7 System calibration You can now calculate the levels assigned to the generator in order to
have a constant voltage within the chosen frequency range.

Arrange the setup as shown in the graph:

* PMM Immunity Suite Rel. 2.06 (10/12) - [Automotive] (=]
T8 File  view NI
RICIH| &
Setup table Measure
(O Edit table
PRI
IMMUIITY
SUITE |tab_DefauIt | E]
Table Automatic DEVICE=DEVICE NAME
—————
Generator
Generator
Amplifer (] | ______ MHz |
-40 dB -40 dB
00 Repi coupler U o dBm |
PMMEEI0 Mari
anitar
& 00010317 o[ mA |
BCI M onitor Farward
| u Nl
HJ]]} Device ® dBm |
DEVICE NAME] Feverse
o dBm |
Setups T Components T Settings
@ 1S0 11452 - 4 O 1S0 11452 -5
@ EBCI
Status
() BCI + Curent Probe
[ Exit
5.7.1 Setup table There are different ways to create the table:

- Automatically (select Make automatic table)

- By adapting the automatically created table to the instrumentation
used (select Edit table)

- By completing the entire table manually (select Edit table)

Automotive IE'
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5.7.1.1 Automatic table
creation

To create a table automatically:

- Select Make automatic table
3 Edittabls ) Make automatic table

G

- Select — , assign a name to the table and press Save.

I

Nome fil: |tab_Default A4T vi[ saba |

Salvacome: | Automotive BCI Table Files [*.44T) v| | Annula |

If an existing table is selected, the following message will appear:

Automotive Immunity Settings File Browsing && Saving |

' s\ProgrammilPrr Immunity SuibelVardokomotive.tsa esiske gia.
e Yy Sostituirlo?

Choose YES to overwrite the table.
Choose NO to cancel the operation and return to the main window.

- A comment can be added, if desired.
T able Automatic DEWICE=F-120 |

- Press Start test, then Abort test if you wish to terminate the process at
any time.

[ Start Test | N [ Ahort Test l

A Pause button is also available, and becomes Continue to resume the
process.

| Fauze ‘ N [ Continue ]

IE' Automotive
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The Generator window shows the level (in dBm) entered by the
generator, at a given frequency (in MHz), to generate the voltage

required.
Generator -
. 344e1NMHz |
o 2.3 dBm |

The color of the dot corresponds to the color of the line on the graph.

The voltage applied will be shown in the Power Meter window.
Power eter Fower Meter

®| 1004V | b 2TV

Values outside the selected tolerance will be shown in red; the
generator will adjust the level to bring the voltage back into range. The
color of the dot corresponds to the color of the line on the graph.

During the work session, the generator level and voltage within the
frequency range selected will be shown as a graph.

4000 14.0
000 T30
by W r
20,00 = ot 120
fA—

10.00 \\u""“ 1.0

Ly e

i LM
i) - === 10.0
=
"a 1000 9.0
TG a0
3000 7.0
-40.00 5
H/O.00 5.0
#0.00 4.0
018 201 401 01 i 1001 1201 1400 1BDD 1800 2000
MHz

Wait for the calibration to finish.

-
“:‘E) Calibration Finished

The Status window shows each operation performed by the program
during the calibration phase.

Frequency Sent

Press the Exit button to leave Conducted mode (the button is deactivated
during the calibration phase).

Exit

Automotive IE'
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5.7.1.2 Manual table
creation

' PMM Imunity Suite - Conducted

You may also fill in the entire table manually.

hone

Freq [MHZ]

Level [dBm]

3

01500

01515

01530

01545

01561

01577

01532

01608

01624

01641

01657

01674

01630

01707

01724

01741

01753

01776

01734

01812

01830

01843

@ |IEC 61000-4-6

() CON/Clamp

(%) Clamp + Cument probe

Setups T

Caomponents

T Settings

Setup table
(%) Edittable

tadify

Bemove 22dBm |

Measure

[ Fill Table

| [ clsrTab ]

Diizk.

I Load Browse ‘

[ Save

| [ Erase |

Table information

Tahle Name
Start
Stop
Step

Level

None |
[ .1500 MHz]
| 200.0000 MHz]
L 1004
10.0 V|

Exit

Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Select the desired cell, type in the value, and confirm by pressing ENTER.

Freq.[MHZ]

01500

Level [dBm]

01515

0.1530

01545

01561

0.15%7

01592

01608

01624

01641

01657

01674

n1ean

Automotive
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The amount entered can be deleted by clicking Remove.
tdify

[ Fill Tabl ][ Clear Table |

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

Freq[MHZ] Level [dBm) Freg(MHZ) Level [dBm]
0.1500[v 02 oasily 10z
015758 - 01575 103
016548 - 01E54e 104
01736\ - 01736[e 105
018238 -~ 0.1823]e 06
0131dje 01914|e 107
02mos - 0.2010]e 107
02111|e - n2111]e 108
02216 - 02216ls 109
02327 |m - 02327 |e 1.0
024438 o243 11
075668 075Es 112
02634e nzEddle 13
02828s O2ezEls 114
023708 - 02370/s 115
03118 - e
R oaz7ile 16
03438e 03dzEe N7
035108 0350je 118
03730(e - O37d0je 1.9
03330 03%60je 120
0.4000]v 121 L odoooly 121

The Clear Table command deletes all of the values entered. The
command must be confirmed.

Freq.MHZ) Level [dBm]
o500y 02
0575V 02 I
0IEs4lY 02
01736|Y 0.2
0123y 0.2
01914y 102
02000l 02
3312]15 . 1 ? fire ‘fou Sure vou
; " ;
02327 e wank ko Clear TABLE
02443 e
0.2566| @
0.7694]e oK | annulla
0.2823|e

The Table information pane displays the main measurement settings:

Table infarmation

Table Name E_'Ij‘!'_c_gp_g_ |
Start 1500 mHa|

Stop | 200.0000 MHz|
Step ' 1.00 %)
Level 10.0 V|

[ 515 ]

Automotive
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Once all values have been entered, click Save, then type in the name of the
table and click Save again.

Drizk

I Load Browsze l

[ Save J [ Erase J
Nome file: Calibration-table. 44T v|[ sava |
Salva come: |Ta|:u|e Files [*.A41) v| [ Anrulla ]

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE Table as

Z:AProgrammit PFMM Irnmunity SuikelCalibrationst Calibration-table. 44T esiste gia,
. Sioskibuirlo?

s =]

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm the

command.
ERASE FILE TABLE
Cercain: | |5 Calibrations

Calibration. A4T
Calibration-table. 44T

&

Documenti
recenti

[

Desktop

.1'5

-
- o
Y o
i = 3
£ =} ;
o »
=

Rigorse del
w | [ Apri l

computer Marme file: | Calibration-table 44T

:v_l[ Annulla ]

e Tipo file: | Table Files [*.A4t)

[ &pri in sola letiura

Rizorze di rete

Calibration-table.A4T  [X]

D Are You Sure you
\_-(/ wartt ko ERASE IT
FROM Digk, ?

[ Ok l [ Annulla

Automotive
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5.7.1.3 Modifying an
existing table

MM Immunity Suite Rel. 2.06 (10/12) - [Automotive] @
T8 File wiew IR
Calibration-table Setup table Measure
Freq [MHZ] Level [dBm] - =
0.090|y 28 (&) Edit table () Make automatic table
0.091|v 28
0.092[v 2.8 tadify
0.093[v 2.8 f o
R |
0.094[v 2.8 | | i | i- |
0.095[v 2.8
00961 T [ Fill T able l [ Clear Table l
0.096[v 2.8
0.097[v 2.8 Disk.
0.098[v 2.8
00337 BT [ Load Browse l
000y 28 [ < l [ £ l
oiotfy 28 ekl ek
0102y 2.8
0103[v 28 Table information
010d]v 28 p_—
0A0B|v 28 Table Name  |Calibration-tabl|
oiorly 28 Start [ MHz|
0.108[v 2.8 =
0103y’ 28 Stop | 40
0110]y 28 Step | i
DAy 28 1
nitz)y 28 Level L 100V
oy 28 B4 Device | |
[T able Automatic DEVICE=F-120 [
Setups T Companents T Settings ]
Measure T Break points T Charts
Frequency Limit narme ;
Stat | 0.090|MHz  [Defaut |(.] ~ DwellTime |  1000| ms
Stop | 400.000| MHz Power limit Factor [_4' x
Step |71 .DI]_i % Modulation =
Type | Int AM 1KHz vI Muliscan [ Exit
Step percent Depth BIJJ % Enablet

An existing table can be adapted to the instrumentation used.
Check the information in Setups, Components and Settings.

Go to Setup table -> Edit table.

Automotive 5-17
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Call up a previously created table by clicking Load_Browse, then
selecting the table and clicking Open.

Disk

I Load Browsze l

[ e | een |

Table File Browsing & Opening

Cerca in: l'f} Calibrations vi ¢ ? o -
Y Calibration, 44T
Bl :} [=] calbration-table. A4T
Documenti
recenti
€
Desktop
Documenti
Rizorze del ; ,
computer Mome file: iCaIibration-table.ﬁdT hal I i ]
& Tipo file: | T able Files [*.A4t) vi [ Annulla ]
it [ &pri ity zola ketturs

Select the desired cell, click Remove, type in the new value, and
confirm by pressing ENTER.

table T0v
Freq.[MHZ] Level [dBm]

0.1500[v 28
01515|v 28 B
01530]v 23
0.1545| 28
0156T|v 2.3
0A577|v 28
0.1692(v -2.8 b odify
01e08|v 28 r i
D124y 28 [ Remave l rRZ B |
01641|v 23 7
LSy 28 [ Fill T able ] | Clear Table ]
0.1674|v 28
A camles il

Automotive
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To delete all data, select Clear Table and confirm.

Are You Sure yaou

9
a?/ warit to Clear TABLE 7

o]

annulla

If several values need to be entered between two end points, use the Fill
Table command. The required values are generated by a mathematical
formula and marked with a red dot.

table 150400

Freq. [MHZ] Lewel [dBm] - |
ois00ly 02 ]
0167y A0z
01654y d02
0A736y 02
0823w
01914|w
0.2010]e
02111|e
0226y d14
n2azrly A14
D243y A4
025EE[Y 14
DZEmAly 14
DomEly A4
ooafoly d14
oaiely 14
naz7aly 24
034y 21
R CE
na7mly 21
REE CEEX
manmly  dz1 Bd

tablz 150400

o |

Freq.[MHZ] Level [dBm]
0.1500fv -10.2
01575 -10.2
0.1E54[v -10.2
0.1736[v -10.2
0.1823| = -10.4
0.1914|m 0.7
0.2010| -10.8
0.2111|= -11.2
0.2216[v -11.4
02327 v 114
0.2443[v -11.4
0.2566(v -11.4
0.2694(v 114
0.2828[v -11.4
0.2970(v -11.4
03118y -11.4
0.3274[v 121
0.3438[v 121
0.3610[v 121
0.3790[v 121
0.3380{v -12.1
0.4a00fy 121

kd

The Table information pane displays the main measurement settings.
Table infarmatiot

Table Name

Start
Stop
Step

Level

|None

1500 MHz|
| 200.0000 MH:z|
1.00 %|
10.0 V|

Automotive
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Once all values have been entered, click Save, then type in the name of the

table and click Save again.
Disk,

I Load Browsze l

[ e | een |

Nome file: Calibration-table. 44T v|[ sava |

Salva come: |Ta|:|le Files [*.Adt) V| [ Annulla ]

If an existing table is selected, a confirmation message will appear to make
sure you want to overwrite the file.

Save FILE Table as

A ProgrammilPRM Inmunity SuibelCalibrationstiCalibration-table. A4 T esiste gia,
L) Sostikuirlo?

The Erase command deletes all data in an existing table. Select the
table in the ERASE FILE TABLE window and click Open, then confirm

the command.

ERASE FILE TABLE

Cercain: |lf} Calibrations v| ] ?‘ % .

Calibration. A4T
Calibration-table. 44T

&

Documenti
recenti

[

Desktop

.1'5

-
- o
Y o
i = 3
£ =} ;
o »
=

Rigorse del
computer Mome file: |Ealibrati0n-table..&4T o | [ Apri l

i Tipa fil: | Table Files [~.441] [l [ Annaia |
[ &pri in sola letiura

Rizorze di rete

Calibration-table.A4T  [X]

9D Are You Sure you
\_-(/ wartt ko ERASE IT
FROM Digk, ?

[ Ok l [ Annulla
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5.8 Immunity test WITH
Impedance
Requirements
(Setups)

If a bulk current injector is used, the AE configuration must present
common-mode impedance (consult EMC regulations for further details).

If the impedance requirements are satisfied, select BCL.

PRI

IMMUNITY
SUITE

Generator

GEHERATORE 3030

[
Amplifer [
i
AE EUT
DEVICE MAME]
Setups T Components T Settings
@ 1S0 11452 -4 O 1S0 11452 -5

@ EBCI

() B C | + Current Prabe

Automotive IE'
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5.8.1 Starting the test

' PMM Imunity Suite - Conducted

Go to Measure.

EEX

Setup table Measure
40.00 Generator
it Frequency
1L
3977 MHz
20.00 Lewal
1000 ® -2.8 dBm
0.00 [ RF
E 000
m Measures
-20.00 "
-30.00
-40.00
-50.00
H0.00 :
018 201 401 E0.1 801 01 1207 1400 1EQ0 1800 2000 ( T ]
MHz
1 ~ |
1 Abort Test Pause
. = i
/|
=i Status
i Sending Level
= - ending Leve ‘
(| titor . i Exit |
Click Start Test.
If no setup table has been selected, the following message will appear:
PMMImmunitySuite
Mo Calibration Table selected, please select it before to continue.
Table File Browsing & Opening
Cercain: |lj Calibrations v| € ? . .
= [ calibration. 64T
{ é} e calibration-table. a4T
D ocumerti
recerti
@
Desktop
[rocumenti
Rizorse del
computsr | Nome file: | Calibration. 44T vl [ o]
‘g Tipo file: | Table Files (~41) v| [ annla ]
Hisors‘e ::Ii A [ &pri in sola lettura
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Otherwise the message that appears is as follows:

PMMImmunitySuite

Selected Calibration Table is "Calibration-table", would vou like to change it?

| T

Choose Yes to view the Table File Browsing & Opening window and
select a different table. Choose No to use the file shown and open the
following data entry window (the date and time are entered
automatically).

Immunity Suite - Info & Log

Test Report

Date 021122009 | Time  [12.39.18 |

Title | |[:] Company | |
ELLT. | | s | |
Ambient

Temperature | | Humidity | |%  Atm. pressure | imh
Table table_10v Operator |

IMote;

Done

Enter the name of the immunity test.

Title | ]

Click [I] and enter the test name, then Save.

Marme file: E::m::]r_m:te:l i=c i V| | Salva I

Salva came: | Tent Files (% t) > Aol

If an existing test is selected, a confirmation message will appear.

Save File Report as

T\_\. C:\ProgrammmitPMM Immunity Suite\Reports\ Conducted_test_80_90.txt esiste gid,
*

Sostituirlo?

Fill in the fields Company, E.U.T., S/N, Temperature, Humidity, Atm.
Pressure, Operator and Note.

Automotive IE'
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The data entry window is now complete:
Immunity Suite - Info & Log

Test Report

Title [Conducted_test_10v.64 |[L] company NardasTs |
E.LLT. !Nome del dispositivo softo test | SN |FRTD_D1_5A§§1_—|
Ambient

Temperatmel 22| Humidity | sg/% Atm. plessulei 11ggi|nh

Table [table 10v | Operator |Rossi Mario

MNote:

Dane Abort

Confirm with Done to start the immunity test.
If an existing test is selected, a confirmation message will appear:

whould you like to cancel the old file?
! If MO the new data will be append
to the end of existing File.

= 1w ]

Choose Yes to overwrite the data with the test in course.

Choose No to append the new data.

' PMM Imunity Suite - Conducted

EEX

Setup table Measure
4000 Generator
Frequency
3000
54.2432 MHz

2000 Livel

i e -1.5 dBm

0.00 [ RE
=
= 000
m Measures

20.00 y

3000

-40.00

A0.00 —

"
H0.00
015 201 40.1 B0.1 80,1 1201 140.0 1600 1800 200.0 [ [ r— ]
| Abort Test H Pause ]
1 i
. = || DT
} -
| —
: - i Status
fale | 10 W Ranpe|10 f
p— Foreai o dans 2o Sending Level ‘
i N are
= tor | B vaue| 667 Range[10omA o | Exit |
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During the test, the Generator window shows the level extrapolated
from the setup table and used by the generator to obtain the required
voltage.

The color of the dot corresponds to the color of the line on the graph

Frequency

6101 MHz

Lewel

® -2.8 dBm

During the test, the frequency range and generator level will be shown in
graph form.

40,00

3000

20,00

1000

n.on

A0on

dBm

-20.00

3000

-40.00

-B000

G000
015 207 401 B0 801 1001 1207 140.0 TED.0 180.0 2000

MHz

At any time, the test can be terminated by clicking the Abort Test button

and confirming:
ABORT TEST X

b 4 Sure wou wank

ta FINISH?

0] 4 annulla |

Automotive IE'
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The Pause button can also be used at any time to stop the test
momentarily (the generator is set to RF OFF).

In this state, an earlier situation can be recreated or a later one can be
simulated; click the RF button (the generator is set to RF ON), adjust the
frequency and level with the arrows, and click Measure to display the

voltage.
Ge_ner_ator _

Frequency
(4]
8306 MHz |y

Lewel
¢ -28dBm |5
[ RF l

Measures
[ Measure ]

Each time the Pause button is clicked, the following window will appear:

Immunity Suite - Info & Log

40.00

Test Log
0 Time
20.00 Frequency
Level
10.00
I Monitor
0.00 Forward
—
o Reverse
= 000
m MNote:
=
-20.00
-30.00
-40.00
50,00
000
0% 201 40.1 0.1 a0 1001 200 140 | Save |[ Close |
'

MiH=

Automotive
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Pressing Save assigns a marker to the current position for future
reference. At the end of the test, the saved information can be viewed
simply by hovering the cursor over the marker.

1) 2 O [ [ (&1
'I'u-%rkmnﬂ ]

Freq. = 138.2148 MHz
Lewvel = -1.8 dBm

In'ulunitq:-r oot 1
——{Fwid = —
———Rev=e L
P -
The button will now read Continue to resume the test.
40,00 0 @
3000
20000
1000
0.00
—
gJE_ Anon
2000
-30.00
-40.00
000
-E0.00
015 201 401 B a0 1001 1201 1400 TRO0 1800 2000
MHz

The status window shows each operation performed by the software
during the test.
Frequency Sent

The end of the immunity test will be announced with the message:

X]

L]
1 ,;' Test Finished

Automotive 5-27
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When the test is over, the graph can be saved in .omp format by right-
clicking anywhere in the graph and selecting Save bmp.

40,000 o a
3000

20.00

1000

000

1000

dBm

-20.00

-30.00

-40.00

H0.00

-B0.00
015 20.1 401 B0.1 801 1004 1201 140.0 1600 1800 2000

MHz

In the next window, assign a name to the graph and press Save.

Maome: file: | aph_tezt BO-50 V| [ Salva ]

Salva come: | bitrap T, bmip] vl[ Arinulls ]

The saved graph can be inserted into a text file using the Editor feature
(see the Editor section for details).

Press the Exit button to leave the immunity test..
| Exit

Automotive
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5.9 Immunity test
WITHOUT impedance

If the impedance requirements cannot be met, the current produced by
the induced voltage must be checked using a supplementary probe

requirements (Setups) placed between the Bulk Current Injector and the EUT (see EMC
regulations for further details).
For this configuration, select BCI + Current probe.

Generator
GEHERATORE 3030 [

Amplifer

]
PMMG00011 ]

3><F'MMBBSD

0 -40 4B -40 4B
FiF Dir. Coupler

=

FHPMMERI0
0010317

O EBCI

(%) B C1 + Current Probe

AE EUT
[DEVICE MAME|] [ TIPICAL |
_§_gﬂ_|_p_§ T Components T Settings
@ 1S0 11452 - 4 150 11452 -5

This procedure provides only significant differences with respect to the

previous test.

Automotive
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5.9.1 Monitoring the Go to Measure.
current

CIEX]

' PMM Imunity Suite - CondLRted

Setup table Measure

40.00 100.0 Generator

— S | Frequency

Al

1624 MHz
20,00 200 Level
10.00 200 ® -2.8 dBm
0.00 600 | s

= -
= 000 5005
% }:, Measures

-20.00 400 Maritar

hd 2.02 mA

3000 a0 e

-40.00 200

-A0.00 100 —

£0.00 o

018 201 401 B0 801 100 120 1400 160D 1800 200.0 [ MEHSIiE ]

Abort Test l [ Pause

e Statuz
_| - Sending Level

[ Exit |

- Minitor

The example below shows the current and the generator level during a test
in which the current limit is exceeded and then brought back into range by
the software. The correct generator levels will be saved and used during
the second sweep.

4000 | 1000
3000 I 00
2000 800
10.00 700
0.00 L L 50D
= i \ !J
-
= 1000 50.0=S
1] / | 2
T 2 f an0
2000
7 ! i
000 b4 i 300
4000 ,/ 200
,_(f
50,00 o \L/ 100
//
000 00
015 z01 401 BO1 8O0 1001 1201 1400 1600 1800 2000

MHz
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5.9.2 Second Sweep

When the process has finished, you can save the new table calculated
during the first sweep. If no name is assigned, the program will use the
name of the previous table and add " modified" (e.g. tabc_
10v_maodified.fct).

After the file is saved, a prompt will appear to conduct a second sweep
with the new table.

9 i
\-?/ Would you like £o start the second sweep

L3 J[ mwo |

Selup table Me

anon 100.0 Generator
[ Fiequency
30.00 ann
200.0000 MH
20,00 a0 a8
- - ® 1.3 dBm
0,00 &0 | O
E oo N 003
£ 00 5003
m | Measures
20,00 a0 Manitor
-30.00 w00
40,00 ma o
50,00 0.0 Jr——
50,00 0o = =
018 201 401 601 a1 1001 1201 1400 1600 1800 2000 m
MHz
Setups T Components T Settings 3
Measure T Break points T Charts Start Test | Pal
Firarh hine Chist Ricferanra nositin Rlafaraneah Famme A ¥
5 | k.|

At the end of the test, the table will appear with the new values marked
by a red dot.
L1

Bad |V -1l
01736V -10.2
[.1523 ]| = 104
0.1914|» -10.7
. 207110] = -10.9
021771 |» 1.2
[ B Ay Bl R 44 4

[ 531 ]

Automotive
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6 — PMM Immunity Test
Editor

6.1 Introduction to Editor This section explains how to view and correctly interpret the data acquired
by the immunity tests.

Start Editor by clicking the button ﬂ .

File. F"=earch
F T
5l

Untitled ]

EEE 3 LihH| B 1 U 9 WialUnicode M5 ~||[8 ~|| = | (B | &]

g

| MUM ' 11.43 17¢11/2009
Fig. 6-1 Main window — Editor

This window contains:
1. Menu
2. Command bar

3. Main window

Document PMMISEN-11104-2.16 — © NARDA 2021

Editor
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6.2 Creating or opening To create a new report, select File -> New
a report

To open an existing report, select File -> Open or use the button on

Edit Search the command bar.

o[-0 Chrl4-M

HIner RelEm

FIEH Edit  Search
Tlew Chrl+M

OpEn 40
Sz hells

= In the window, select the file in the Reports folder and click Open.

Apri @

Cerca in |¥-_‘}Flep0lts _-:J g |‘=_“F ,

2] conducted_test_s0_20
.—J [l radiated test
Recent =) strafie

[ abc_1017_11_2009 14_53_36.WHL
| table_150 400 17_11 2009 14_57_39.WHL

i\

~
|

Desklop

\$

Documenti

&

Rizorze del
compuber

-

Marre fils: |F| adiated_test 8090 L] Apri

Fizorsedirete  Tipo file: |80 Files ) x| Annla

I Apriin zola lettura

The file will appear in the main window.

)

' Editor [C:\Programmi\PMM Immunity Suite\Reports\Radiated_test BO_90.txt]

EEG [ EMB B £ U S | [CouerNew ~| |85 ~||:= |5 | &
EN £1000-04-03 - PHM Inumuwnity Suite ~
Date: 1671172009
Time: 15.55.E52
Coupany name:
E.U.T. name: Home del dispositivo sotto tCest
E.U.T. 5/N: FROOLSAZ3L
Operavor: Rossi Mario
Test equipment:
Cenerator: Narda-2T2 MM 20300SE
Power Meter: Hards-STS DUAL 6630
Field Meter: MNarda-gTE2 MM EPEOL
Aubient data:
Tenperature: EZ
Humidity: 50%
Atu. pressure: 100ub
Hote:
Test settings:
grart Fregquency: S0 MHz |
Stop Fregquemcy. 50 MHz
Step Frequency: 1 %
Modulation type: Int &M 1FHz
Modulation depth: BO %
Limit: 10V/m
Tollerance: 1V
Dwell time: 1 =
Calibration Table neue: table 80_30
Event log n"l - Time: 15.56.47 - Elapsed time: 00:00:43
Generator Fregquency: S1.608000 MHz
Cenerator Level: -37.Z dEw ~
CAPS MUK 1INS 1234 18/11/2003

Editor
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6.3 Report format Below is an example of the report generated at the end of the immunity
test:

)

*" Editor [E:\Programmi\PMM Immunity Suitel\Reports\Radiated_test BO_90.txt]
EEE | B £ U S & | |CouierNew ~| |82 ~| | =& &

EN 61000-04-03 = FPHM Inmmunity Suite

Date: 1e/117200%
Time: 15.5E5.53

Conpany hames:

E.UT.T. name: Nome del dispositivo sobtbo test
E.U.T. 5/N: FROOLSAZZ1

Operator: Rossi Mario

Test equipment:

Generator: Narda-5T3 PMIT 2030USE
Power Meter: Narda-STS DUAL 530
Field Meter: Narda-5TE FMIT EFPc0l

Ambient data:
Tenperature: IZE
Humiditsy: EO%

Atm. pressure: 100mb

Note:

Test settings:
Start Fregquency: 20 MHz
Stop Frequency: 20 MH=
Step Frequency: 1 %
Modulation type: Int AM 1FH=
Modulation depth: 20 %
Limit: 10V /m
Tollerance: 1W/m
Dwell time: 1 =
Calibration Table name: table S0 90

Event log n®l - Time: 1E.E5.47 — Elapsed time: 00:00:49
Generator Fregquency: 21.&023000 MH=
Generator Lewel: -37.Z dBm
Forward Lewvel: 5.1 dBm
Reverse Lewel: -—-10.4 dBm
Note:

Event log n®Z - Time: 15.558.14 - Elapsed time: 00:02:15

Gernerator Fredquency: 84 9Z1610 MH=
Generator Lewel: -37_.2 dBm
Forward Lewvel: 5.5 dEm

Bewerse Lewel: -10.EZ dBm

HNote:

Event log n®3 - Time: 1E5.58 £5 — Elapsed time: 00:0Z2:Z26
Generator Fregquency: 28383770 MH=
Generator Lewel: -27.32 dBm
Forward Level: 2.3 dBm
Deverse Lewvel: -10.4 dEm
Note:

NLIM [ Ih 1213

The format is highly user-friendly and clearly presents all of the information
gathered during the test. The information in bracket 1 concerns the
equipment under test, the instrumentation used and the ambient data.
The rest includes all events that interrupted the test; they are listed in
chronological order along with the data acquired at the time of the
interruption.

Editor
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6.4 Modifying the report

Editor

The report can be adapted to your needs through a series of
commands:

- To modify the contents.
Search

IInda Chrl+Z

iZuk CErH
Paste CEr+P
Copy kT
Clear Zkrl+D

Select Al A g&’ [:-I E}

The Edit menu allows you to Copy, Cut, Paste, and Clear text.
The entire text can be selected with the Select All command.
In case of error, the Undo feature will reverse unwanted modifications.

- To add images:

Click the _- J icon on the command bar to insert .bmp images into the
report.

Cercain: | ) Reports ~ @« =5 B

s [arafica_test 80 90:
Fecent

=
[

E:
Deskiop

LY/

Diocumenti

Rizorse dal
computer

Q tHome file; |Grafico_test_8l3_9[l L] Apri |
Rizorze ditete  Tipo file: | bitmap [* brap] ] Annulla

I Apriin eola lettura

Select the file and press Open.
- - To change text and color formatting.

Select the part to be modified (by holding down the left mouse button) or
the entire report (Edit ->Select All, then change the appearance of
the text using the buttons and dropdown menus on the command
bar:

B r U = &= Jl@ﬂ-.riaILlnicndeMS L] ]IB L] =
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6.5 Saving the report

@l=8 Edit Search
Save Chrl+5
Save As  Chrl+A

@TE

6.6 Printing the report

Edit. Search
I Frint ChiT

Ferik el
=

6.7 Leaving Editor

Edit.  Search
Exlk Chr

To save the report, click:
- Save: to overwrite the document in use, or.

- Save As : to save in one of three formats:
+ Calibration log Files (*.WHL)
o Textfiles (*.txt)
* Rich Text Files (*.rtf)

All files saved in .txt can be viewed by other applications. In Word or
Excel, search for the report using the Open file command with File
type: All files (*.*). Select the report from your folders and click
Open.

Print the report by clicking File -> Print or the d-;h button on the
command bar

Close the file with File -> Exit or the ﬁj button on the command bar.
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Caro cliente

grazie per aver acquistato un prodotto NARDA! Sei in possesso di uno strumento che per molti anni ti garantira un’alta qualita di servizio. NARDA riconosce
I'importanza del Cliente come ragione di esistenza; ciascun commento e suggerimento, sottoposto all'attenzione della nostra organizzazione, & tenuto in grande
considerazione. La nostra qualita € alla ricerca del miglioramento continuo. Se uno dei Suoi strumenti NARDA necessita di riparazione o calibrazione, puo
aiutarci a servirla piu efficacemente compilando questa scheda e accludendola all’apparecchio.

Tuttavia, anche questo prodotto diventera obsoleto. In questo caso, ti ricordiamo che lo smaltimento dell'apparecchiatura deve essere fatto in conformita con i
regolamenti locali. Questo prodotto & conforme alle direttive WEEE dell’'Unione Europea (2002/96/EC) ed appartiene alla categoria 9 (strumenti di controllo). Lo
smaltimento, in un ambiente adeguato, puo avvenire anche attraverso la restituzione del prodotto alla NARDA senza sostenere alcuna spesa. Puo ottenere
ulteriori informazioni contattando i venditori NARDA o visitando il nostro sito Web www.narda-sts.it.

Dear Customer

thank you for purchasing a NARDA product! You now own a high-quality instrument that will give you many years of reliable service. NARDA recognizes the
importance of the Customer as reason of existence; in this view, any comment and suggestion you would like to submit to the attention of our service
organization is kept in great consideration. Moreover, we are continuously improving our quality, but we know this is a never ending process. We would be glad if
our present efforts are pleasing you. Should one of your pieces of NARDA equipment need servicing you can help us serve you more effectively filling out this
card and enclosing it with the product.

Nevertheless, even this product will become obsolete. When that time comes, please remember that electronic equipment must be disposed of in accordance
with local regulations. This product conforms to the WEEE Directive of the European Union

(2002/96/EC) and belongs to Category 9 (Monitoring and Control Instruments). You can return the instrument to us free of charge for proper environment friendly
disposal. You can obtain further information from your local NARDA Sales Partner or by visiting our website at www.narda-sts.it.

1 Servizio richiesto: M Service needed:

1 Solo taratura O Riparazione [ Riparazione & Taratura O Taratura SIT O Altro:
[] Calibration only [ Repair [] Repair & Calibration [] Certified Calibration ] Other:
Ditta:

Company:

Indirizzo:

Address:

Persona da contattare: Telefono:

Technical contact person: Phone n.

Modello: Numero di serie:

Equipment model: Serial n.

M Accessori ritornati con I'apparecchiatura: [1 Nessuno [ Cavo(i) [ Cavo di alimentazione Altro:
M Accessories returned with unit: 1 None L] Cable(s) [ Power cable Other:

v Sintomi o problemi osservati: Y] Observed symptoms / problems:

v Guasto: O Fisso O Intermittente  Sensibilea: [0 Freddo [ Caldo [ Vibrazioni [ Altro
M Failure: [ Continuous [ Intermittent Sensitive to: [ Cold O Heat O Vibration O Other

Descrizione del guasto/condizioni di funzionamento:
Failure symptoms/special control settings description:

Se l'unita e parte di un sistema descriverne la configurazione:
If unit is part of system please list other interconnected equipment and system set up:




Suggerimenti / Commenti / Note:
Suggestions / Comments / Note:




